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 أنواع الحاسبات
)�* Å� )�¾ Å#�+ë�Î ���*$ Å#�ÄáßÏêÄ �åø �3ÏÞÅÈ ÌÅÉêÅÛ�Ä 	�ÏßÎ: 

 (Personal Computer)الحاسب الشخصي

)óßï�Ä ÇêÅÛ�Ä !+�� 
�û* Å� ÊàÅ� (pc)  !�ö%È Ù�ë* !�×Ú �. Ë×+Ï� ÇÏ���Ä Ùûê ÇêÅÚ $º
åïÏ�Ä á��$ ÇÏ���Ä Ùûê �%
   äÅ�êº �2 Ë+�ç���Ä �Å��.Ä$ ÇÎÅ���Ä )
 )óßï�Ä ÇêÅÛ�Ä �ÄáßÏêÄ

��Å��Ä )
 Å�ÄáßÏêÄ åÓ�.Ä ÇêÅÛ�Ä �,Ä åÉÏ�*$ (àÅ��Ä ñßï�Ä �$Å�Ï� )
. 

 

 
 (laptop) الحاسبات المحمولة

 å�óÈ ç+�ÏÎ '"$ .Ë�%#ëÈ Å#È ���Ï�Ä ���* á+�Ä ËÉ+�Ú �×Ú )
 Ë�%�Û� Êå+�ò ÌÅÉêÅÚ '"$
 ËÚ%�$ ËîÅï�Ä Ì2ÅÚ )
 ��â$ )�+Éû�Ä �×Û�Ä )
 Ù+ÎÅ�� ËÚ%�$ ËîÅïÈ Å#�+ò%Î ���* Å��.Ù+ÎÅ���Ä

 �Å�ÎäÄ ��ä )óßï�Ä ÇêÅÛ�ÄÊ%� é�� )
 Ë�%�Û��Ä ÌÅÉêÅÛ�Ä åÉÏ�Î$.Ë�*%û�Ä ����Ä ÌÅ�Åê
Å#�×Ú å�ó� ��â �Öå* $ Ë+óßï�Ä ÌÅÉêÅÛ�Ä å�ê 	�ö Å"å�ê. 

 

 
 (palmtop)حاسب الكف

��Ä �×Ú )
 å+�ò ÇêÅÚ %"$ ،Ë+óßï�Ä ÌÅÉêÅÛ�Ä '�¾ !+�� Ë�çß��Ä ÌÅ����Ä ��� ���* $ 	
�%�Û��Ä ÇêÅÛ�ÅÈ Ë�äÅ�� å�ë�Ä õ�ß�� åÉÏ�*$ . 
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 (servers)أجهزة الخادم

 �*çßÎ �Ï* Ñ+Ú Ë�Éï�� )ë+Âå�Ä ç�å��Ä �%�Ï� ÇêÅÛ�Ä ÌÅ�Éî )
 �áßÏëÎ ÇêÅÚ Êç#Öº )"$
� ÌÅÉêÅÛ�Ä  ã" �%�Î �º Ç×*$ ،Ë�Éï�Ä ÊäÄà¾$ ÌÅ�Å+É�Ä ÌÅÉêÅÛ�Ä àá� ÆÅ�+ÏêÄ �� ���ÏÏ� Ë*Å�� Ë*%

 ºáÈ$ Ë�àÅÞ ÌÅÉêÅÛ� �áßÏëÎ ÍÛÉòº Ë+óßï�Ä ÌÅÉêÅÛ�Ä Ê%� ä%ûÎ �� ��Ä%�Ä )
$ ، Å#+�� å+É��Ä
 ًÅÃ+ï
 ًÅÃ+î )�ÅÛ�Ä Í�%�Ä )
 ñ��Ï* Ë�àÅß�Ä$ Ë+óßï�Ä ÌÅÉêÅÛ�Ä �+È �å��Ä. 

 

 
 ç#Öº �� Å#È �óÏ* Å�$ !�àÅß�Ä ÌÅÉêÅÛ�� ��î 

 

 

 الكمبيوترمكونات 
Êç#Öº( !*àÅ��Ä ÌÅ�%���Ä �Å�%� '"$) Hardware ÌÅ+×�åÉ�Ä$ ، Software 

 Hardware (المكونات المادية للحاسب )اϷجهزة

 �ë��Î$ .)�,Ä ÇêÅÛ�ÅÈ �óÏ� $º )�,Ä ÇêÅÛ�Ä )
 )Âå�$ è%��� ÀçÖ (º )" Ë*àÅ��Ä ÌÄáÚ%�Ä
)" �Åë�º Ð3Ò '�¾ Ë*àÅ��Ä ÌÄáÚ%�Ä : 

 �ÅÞà0Ä ÌÄáÚ$ Input Unite. 

 ÔÄåÞ0Ä ÌÄáÚ$ output Unite. 
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 Ë*ç�å��Ä Ë×�Å���Ä ÊáÚ$ CPU. 

 

 Input Unite أوϻ: وحدات اϹدخال

æÅ#×�� Ë��Ïß��Ä Õ�ÄåÉ�Ä$ ÌÅ�Å+É�Ä �ÅÞà¾ �� Ë�%Ãë��Ä ÌÄáÚ%�Ä$ Êç#Ö.Ä ��Î '"$ . 

  : أمثلة لوحدات اϹدخال

 

 : Key Board لوحة المفاتيح .1

�� Ù+ÎÅ���Ä ËÚ%� åÉÏ�Î  �ÅÞà¾ )
 Ù+ÎÅ���Ä ËÚ%� �áßÏëÎ$ .)�,Ä ÇêÅÛ�� ÌÅ�Å+É�Ä �ÅÞà¾ ÌÄáÚ$ �"º
)�� Ù+ÎÅ���Ä ËÚ%� (%ÏÛÎ $ .�Å�äº $ �$åÚ �� ÌÅ�Å+È: 

o  ،أ، ب(مفاتيح الحروف والرموزB  ،A  ،"  ،& ). 

o رقام و العمليات الحسابيةϷمفاتيح اللوحة الرقميةو التي تستخدم في إدخال ا. 

o  سهم وϷالتي تستخدم في تحريك مؤشر الكتابةمفاتيح ا. 

o مفتاح العالي (Shift)  ويستخدم في إدخال الحروف والرموز المكتوبة أعلي
 .أزرار الكتابة وله استخدامات أخرى

o مفتاحي تغيير اللغة (Alt + Shift).حيث يستخدم مفتاحي (Alt + Shift)  في
 Alt) ى العربية. أما مفتاحيالجانب اϷيمن من لوحة المفاتيح لتغيير لغة الكتابة إل

+ Shift)  يسر من لوحة المفاتيح فلتغيير لغة الكتابة إلىϷفي الجانب ا
 .اϹنجليزية
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 : Mouse الماوس .2

åë*º $ ��*º �Ääæ Êä»��� $ .)�,Ä ÇêÅÛ�Ä �ÅÞà¾ ÌÄáÚ$ &áÚ¾ )". 

 á�� . �Ä%�2Ä õ�È )
 ùê%�Ä )
 äæ áÖ%* á�$ ä»��Ä åî½� �åÛÏ* Êä»��Ä �*åÛÎ �+�Ö )
 Ê

.ËîÅï�Ä )�� ÌÅ"Å×Î2Ä �#ê ��î )�� %" $ .  

)" ÌÅ�ÄáßÏêÄ Ð3Ò Êä»��� $: 

o شارةϹا (Pointing)  شارة إلى أيϹبحيث تستطيع ا
 .شيء موجود علي الشاشة

o ختيارϻا(Selection)  يسرϷبالضغط علي زر الفأرة ا
 .أثناء اϹشارة علي شيء معين علي الشاشة

o النقل (Move)يسر  باستمرارϷالضغط علي الزر ا
للفأرة مع سحب الشيء الذي تريد نقله الي المكان 

 Drag)الجديد و تسمي هذه العملية سحب وإسقاط

and Drop). 

 

 :(Scanner) الماسح الضوئي .3

 �ÅÞà0 )�,Ä ÇêÅÛ�ÅÈ !�+ò%Î �Ï* $ .)�,Ä ÇêÅÛ�Ä �ÅÞà¾ ÌÄáÚ$ �� ÊáÚ$ )Â%÷�Ä ÙêÅ��Ä åÉÏ�*
È ÌÅ�%êå�Ä $ ä%ó�Ä å++�Ï�Ä $ Å#�ÄáßÏêÄ ÊàÅ�¾$ ËîÅï�Ä )�� Å#Ï*¼ä �+ûÏëÎ Ñ+ÛÈ Å#�Ä%�º �+�×

Å#+
. 

 

 
)Â%÷�Ä ÙêÅ���  ä%ò 
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 :الميكروفون .4

 $ �ÅÞà¾ ����* Ñ+ÛÈ ÌÄ%ò.Ä �ÅÞà¾ )
 �áßÏë* $ )�,Ä ÇêÅÛ�Ä �ÅÞà¾ ÌÄáÚ$ �� ÊáÚ$ Å÷*º %"
ÌÄåöÅÛ��Ä $º ÌÅÒàÅÛ��Ä õ�È $º �Î%ò �+×ëÎ . 

 :(Digital Camera) الكاميرا الرقمية .5

 �Î ä%ò �ÅÞà0 )�,Ä ÇêÅÛ�ÅÈ Å#+�ò%Î �Ï* $ .)�,Ä ÇêÅÛ�Ä �ÅÞà¾ ÌÄáÚ$ �� ÊáÚ$ Å÷*º )"
Å#+
 å++�Ï�Ä $ ËîÅï�Ä )�� Å#Îá"Åï� �+ûÏëÎ Ñ+ÛÈ Å#øÅ�Ï�Ä. 

 (Disk drives) وحده اϻسطوانات .6

Ë�å��Ä ÌÅ�Ä%ûê2Ä 
*åø �� ÌÅ�Å+É�Ä �ÅÞà¾ ���*  floppy disk %ûê2Ä$Õ�á��Ä ÌÅ�Ä CD 

ROM Ë+��å�Ä ÌÅ�Ä%ûê2Ä$ DVD . 

 output Unite ثانيا: وحدات اϹخراج

 ÇêÅÛ�Ä Å"ã+��ÏÈ �Å� 'Ï�Ä ÕÂÅÏ��Ä ÔÄåßÏêÄ$ ôå� ÌÅ+��� �+�Ö �� Ë�%Ãë��Ä ÌÄáÚ%�Ä ��Î '"$
!+�¾ Å"äÄáò¿È �áßÏë��Ä �Å� )Ï�Ä ÌÅ�+��Ï�� Å�
$ 

  : أمثلة لوحدات اϹخراج

 

 Monitors شاشة العرض .1

 �� )�,Ä ÇêÅÛ�� !�ÅÞà¾ �Ï* Å� ËîÅï�Ä å#ÿÎ Ñ+ÛÈ )�,Ä ÇêÅÛ�Ä ÔÄåÞ¾ ÌÄáÚ$ �"º �� )" $
ÇêÅÛ�Ä æÅ#Ö )�� Å�Éë� Ë�×ë��Ä ÌÅ�Å+É�Ä ËîÅï�Ä ôå�Î Å�� .Ý�Ä ä%ò $ �Å�äº $ �$åÚ 

 :(Speakers) السماعات .2

Þ¾ )
 �áßÏëÎ$ .)�,Ä ÇêÅÛ�Ä �� ÌÅ�Å+É�Ä ÔÄåÞ¾ ÌÄáÚ$ �� ÊáÚ$ )" ÌÅ�Å�ë�Ä ÌÄ%ò.Ä ÔÄå
Ì%ó�Ä ôÅ�ß�Ä $ %�� ËÖäà )
 ��ÛÏ�Ä ����* $ .)�+ê%��Ä$ )�Å�.Ä$ 

 :(Printer) الطابعة .3

 ÌÅ�Å+É�Ä ÔÄåÞ¾ )
 �áßÏëÎ $ .)�,Ä ÇêÅÛ�Ä �� ÌÅ�Å+É�Ä ÔÄåÞ¾ ÌÄáÚ$ �� ÊáÚ$ Å÷*º )"$
 �$åÚ( ÌÅ�%����Ä$-  �Å�äº- �Ää$º )�� Ë�%Éû� )ä%ò 
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!�ÈÅû��  ä%ò 

 (PLOTTERS) الراسمات .4

 ÌÅ�%êå�Ä ÔÄåÞ¾ )
 �áßÏëÎ $ .)�,Ä ÇêÅÛ�Ä �� ÌÅ�Å+É�Ä ÔÄåÞ¾ ÌÄáÚ$ �� ÊáÚ$ Å÷*º )"$
�Ää$º )�� Ë�%Éû�  å+É� �Å×Ú»È Ë+êá�#�Ä$ Ë+�Å+É�Ä 

 
�êÄå��  ä%ò (plotter) 

 CPU ثالثا: وحدة المعالجة المركزية

 : Î��ÄçÖº Ð3Ò '�¾ Ë*ç�å��Ä Ë×�Å���Ä ÊáÚ$ �ëء $"'

  ÆÅëÛ�Ä ÊáÚ$'�û���Ä Arithmetic logic Unit (ALU). 

 ��ÛÏ�Ä ÊáÚ$ Control unit (CU) . 

 Ë+ë+Âå�Ä Êå�Äã�Ä Main Memory . 
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 $ Û+ö%Î ��î CPUÅ#ÂÄçÖº( ��ـ

 (ALU) وحدة الحساب والمنطق .1

 ÌÅ+����Ä$ Ý�Ä ... Ë�ë��Ä$ Øåû�Ä$ ��×�Ä ÌÅ+��� �Ó� Ë+ÈÅëÛ�Ä ÌÅ+����Ä ءÄåÖ¿È ÊáÚ%�Ä  ã" �%�Î
 Ë+�û���Ä �� åÉ�º ÌÅ+��� �Ó� Ç+ÎåÎ$ æå
 ÌÅ+��� $º ÌÅ+�� �+È Ë�äÅ���Ä Å#+
 �Ï* 'Ï�Ä Ë+��� (º '"

&$Åë* $º �� å�òº $º . 

 (CU) وحدة التحكم .2

 ÌÅÖåß��Ä$ Ì3Þá��Ä �� '
 ��ÛÏÎ Å#�º Ñ+Ú ÇêÅÛ�� Ë��Ïß��Ä ÌÄáÚ%�Ä �+È ÌÅ+����Ä 
+ë�ÏÈ �%�Î
ÇêÅÛ�Ä '
 Ë��Ïß��Ä ÌÄáÚ%�Ä '�Ä$ ��. 

 
Î ��îÇêÅÛ�� Ë�%���Ä Êç#Ö/� )Û+ö% 

 '�¾ ËÉ�ó�Ä Ë�Ä%ûê2Ä '�� Å#�*çßÎ 
Éê )Ï�Ä$ Ë�áßÏë��Ä Õ�ÄåÉ�Ä �+�ÛÎ �Ï* ÇêÅÛ�Ä �+�ïÎ á��
)ÂÄ%ï��Ä �%ò%�Ä Êå�Äâ.(RAM)  Õ�ÄåÉ�Ä �*çßÎ$ ،�Å��.Ä ã+��Î )
 Êå�Äã�Ä  ã" ÇêÅÛ�Ä �áßÏë*$

 �3�¾ á�� Êå�Äã�Ä �å�Î$ .Å#Ï×�Å�� (äÅ×�Ä ÌÅ�Å+É�Ä$ Å#�+�ÛÎ àÅ�+� )Èå#��Ä äÅ+Ï�Ä �Åû��Ä $º æÅ#×�Ä
æÅ#×�Ä �+�ïÎ ÊàÅ�¾ á�� Õ�ÄåÉ�ÅÈ. 

 الذاكرة .3

 Äã� ��ã� �Åë�0Ä ÔÅÏÛ* Å�� Å�Å�Î Å#�� ��Å�Ï* )Ï�Ä ÌÅ�%����Ä å�ãÎ$ �ÅÖåÏêÄ )�¾ ÇêÅÛ�Ä ÔÅÏÛ*
��ä Êä%ò )
 �çßÎ �Ò ÌÅ�%����Ä Õ�Å�Î.Ë�ÂÄà Ë�óÈ $º ÅًÏ�½� Å�¾ ÌÅ�%����Ä ý�Ú Ç×* �ÄáßÏêÅÈ Ë+

(ù�
 �+��ä �áßÏë* (ã�Ä (àá��Ä �Åÿ��Ä %"$ ،)ÂÅ�Ó�Ä �Åÿ��Ä0  ،1 �Åÿ��Ä �áßÏë� Å�ÎÅ+Ú )
 �Û�$.)
 )�¾ å�ò ��( �Å�äº Êåï� �áßÏë* (ã�Ä (åï��Ä9). 

 وحدات القياس الذاكره: Ë+Î,Ä Ë�Èä.Ä Ë+êÅê.Ä ÌÄáÚ%�ÅÈ Êå�Äã�Ä Ë�ê èÅ�Î : 

 الخانة البايت Byte : äÄá�� '" áÚÄ$ �åÚ �+Ó�Ï� ËÈ%�û��Ä Êå�Äã�Ä
ÍÈ( ÌÅ�ÅÞ '�Å�Ò �� )Í*ÅÉ�Ä( Ë�Åß�Ä �%�ÏÎ$ ،'ÂÅ�Ó�Ä �*$áÏ�ÅÈ Bit )  &Ä

( �++ÂÅ�Ó�Ä �+��å�Ä �+Ó�Î Å#���* 'Ï�Ä$ 'ÂÅ�Ò ��ä0  ،1). 

 الكيلو بايت Kilobyte: KB  = áÚÄ%�Ä Í*ÅÈ %�+��Ä$1024 Í*ÅÈ. 

 الميجابايت Megabyte :: ÏÞÄ ( Í*ÅÈ Å×+��ÄäÅó M $º MB ) = 

1024Í*ÅÈ%�+�. 

 الجيجا بايت Gigabyte:äÅóÏÞÄ ( Í*ÅÈ Å×+×�Ä G  $º GB ) = 1024 

Í*ÅÈÅ×+�. 
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 أقسام الذاكرة الرئيسية Main Memory :  

)" �Ä%�Ä Ð3Ò '�¾ Ë+ë+Âå�Ä Êå�Äã�Ä �ë��Î : 

 ذاكرة التداول العشوائي Random Access 

Memory(RAM) :  Êå�Äã�  ã" �É�ÏëÎ ÊáÚ$ �� Õ�ÄåÉ�Ä$ ÌÅ�Å+É�Ä
 �%�Î$ 
û���Ä$ ÆÅëÛ�Ä ÊáÚ$ �� ÕÂÅÏ��Ä �ÅÉ�ÏêÅÈ �%�Î Å�� �ÅÞà0Ä
 �ó
 àå×�È Å#Ï*%ÏÛ� Êå�Äã�Ä  ã" á��Î Ñ+Ú ( ًÅÏ�½� ًÅ�*çßÎ �#�*çßÏÈ
 ÌàÄæ Å���$ . Êå*ÅûÏ��Ä $º ËÏ�½��Ä Êå�Äã�ÅÈ Í+�ê Äã� ) )Èå#��Ä äÅ+Ï�Ä

$ ÌÅ�Å+É�Ä Ë+�� ÌàÄæ Êå�Äã�Ä Ë�ê '
 Å#�$ÄáÎ ���* 'Ï�Ä Õ�ÄåÉ�Ä �×Ú
Í�%�Ä é�� . 

 ذاكرة القراءة فقط Read Only Memory (ROM):  '�� &%ÏÛÎ
 ÌÅ�Å+É�Ä ��Î$ åÎ%+É���Ä �+�ïÏ� Ë�æ3�Ä Ë+êÅê.Ä ÌÅ�Å+É�Ä$ Õ�ÄåÉ�Ä
 2 ËÏÈÅÒ Êå�Äâ '"$ . Ë��ó��Ä Ë�åï�Ä �É� �� Å#�+×ëÎ �Î á� Õ�ÄåÉ�Ä$

Èå#��Ä äÅ+Ï�Ä �Åû��ÅÈ åÒ»ÏÎ ���* 2 !�. ù�
 ÊءÄå��Ä Êå�ÄãÈ Í+�ê$ '
 ���* �È �áßÏë��Ä ËûêÄ%È Å#ÎÅ*%ÏÛ�� ءÅ��0Ä $º �*á�Ï�Ä $º Å#+�� ËÈÅÏ��Ä

Å#�ÞÄáÈ Å� ÊءÄå� ù�
. 

 الذاكرة المخبأة (cache memory):  �+�ïÏ�Ä ÌÅ+��� �3Þ �áßÏëÎ$
 Ë�åê �%�Î ÄáًÖ Ë+�Å� Ë�åê ÌÄâ Í�½� �*çßÎ Êå�Äâ �� ÊäÅÉ� '"$

ã�Ä Æ%�û��Ä ÌÅ�+��Ï�Ä$ ÌÅ�Å+É�� Í�½��Ä �*çßÏ�� �áßÏëÎ$ .Ë+ë+Âå�Ä Êå�Ä
 '�� á�Åë* Å�� ÌÅ�Å+É�Ä �+�ïÎ ÌÅ+��� ءÅ�Òº Êá*á� ÌÄå� Å#�ÅÖåÏêÄ

 )�Ä%ÛÈ Ê»Éß��Ä Êå�Äã�Ä Ë�ê äá�Î$ . ÌÅ�Å+É�Ä �+�ïÎ Ë�åê512  %�+�
åÓ�Ä $º Í*ÅÈ. 

 وحدة التخزين Storage Devices: 

�Ä '" �*çßÏ�Ä ÌÄáÚ$ ��Î �ë��Î$ Å#+�� Õ�ÄåÉ�Ä$ ÌÅ�Å+É�ÅÈ üÅ�ÏÚ2Ä ���* 'Ï�Ä ÌÄáÚ%
 Ëø%�÷��Ä ÌÅ�Ä%ûê2Ä$ ،Ë�å��Ä ÌÅ�Ä%ûê2Ä$ ،ËÉ�ó�Ä ÌÅ�Ä%ûê2Ä :'�¾ ÌÄáÚ%�Ä

äç+��Ä ÌÅ�Ä%ûêÄ( CD)  Êå�Äâ$ ،ù�����Ä ù*åï�Ä$ ،Ç�Ä%×�Ä Êàá�Ï��Ä Ë+��å�Ä Ë�Ä%ûê.Ä$ ،
ì3��Ä. 

 
 ÌÄáÚ%� !�Ó�º Ùö%* ��î�*çßÏ�Ä 

 سطوانات الصلبةϻا Hard Disks :  á+�Ä 	� �×Ú '
 Êå+�ò  áÚ$
Ë*ç�å��Ä Ë×�Å���Ä ÊáÚ$ '
 !ÏÉÓ�$ Å�ÂÄà Ë�óÈ áÖ%Î ÅÉ*å�Î (CPU) 

 Ë+�*çßÏ�Ä Ë�ë�Ä ��Î �óÎ Ñ+Ú Ë+�*çßÏ�Ä Å#Ï�ê åÉ�È Ë�Ä%ûê2Ä ç+�ÏÎ$
ÅÉ*å�Î �åÚ ÌÄäÅ+�� åï� &º ÆÅÏ� �2¸ Êåï� �� åÓ�Ä �*çßÎ '�Ä . 
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Ç�ó�Ä ðå��Ä ��î 

 سطوانات المرنةϻا Floppy Disks:  ÌÅ�Ä%ûêÄ Å�" �+�%� Å#�� áÖ%*$
 Ë�å�3;5  åÿ� ÌÅ�Å+É�Ä ý�Ú Ë+��� '
 �,Ä Ë�áßÏë��Ä '"$ Ëò%È

 Ë�å� ÌÅ�Ä%ûêÄ Å#� Ë+�*çßÏ�Ä Ë�ë�Ä �×Ú åÉ�$ Å#�×Ú å�ò5;25  ��
Å#�×Ú åÉ�$ Å#� Ë+�*çß�Ä Ë�ë�Ä �×Ú å�ò åÿ� �,Ä �áßÏëÎ á�Î . 

 

 سطوانات المضغوطةϻا (اسطوانات الليزر CD) Compact 

Disks :åÉÏ�Î äç+��Ä ÌÅ�Ä%ûê2Ä $º Ëø%�÷��Ä ÌÅ�Ä%ûê2Ä   ÐáÚÄ
 Ñ+Ú ،%*á+��Ä ÌÅû��$ Ì%ó�Ä �*çßÎ '
 �áßÏëÎ Ñ+Ú �*çßÏ�Ä �ÂÅê$

 '�Ä Ë+�*çßÏ�Ä Å#Ï�ê �óÎ650  .�åÚ �%+�� �%ë�Þ$ ËÂÅ�Ïê (º
 Å#�º Ë+�%��Ä  ã" '�� Ç+�*$���* 2  ù�
 ÊáÚÄ$ Êå� 2¾ Å#+�� �+×ëÏ�Ä. 

 

 سطوانة الرقمية المتعددة الجوانبϷا (DVD Digital Versatile 

Disk):  �*çßÏ� �áßÏë* Ë�ë�Ä )�Å� Ë×�á��Ä ÌÅ�Ä%ûê.Ä �� �%� %"$
2-10 Ë×�á��Ä Ë�Ä%ûê.Ä �áßÏëÎ$ .ÌÅ�%����Ä �� Í*ÅÈ Å×+Ö (CD) 

 �áßÏëÎ Å� ÊàÅ�$ '�+ê%��Ä �*çßÏ�Ë+�Å� Êà%×È �3
º �*çßÎ )
  �� 2áÈ
%*á+��Ä ùÂÄåî. 

 شϼذاكرة الف (Flash Memory) : ÌÅ�Å+É�Ä ý�Ú )
 �áßÏëÎ Êå�Äâ )"
 �� åÓ�Ä )�Ä �óÎ Ñ+Ú Êå+É��Ä !+�*çßÏ�Ä Ë�ë�Ä$ �×Û�Ä å�óÈ ç+�ÏÎ$
 åÓ�Ä Å#+�� ËÈÅÏ��Ä$ Å#+�� �� ÌÅ�Å+É�Ä Ùë� Å÷*º ���* Å�� ،Í*ÅÈ Å×+Ö

 �Ï*$ Êå� ���Þá� ËûêÄ%È ÇêÅÛ�ÅÈ Å#�+ò%Î USB . 
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ì3���  ä%ò 

 �� ùÈÄåÎ (á�$ Ë�3��Ä ØÅ÷*¾ �� áÈ2 �+ó�Ï�ÅÈ Ë*àÅ��Ä ÇêÅÛ�Ä ءÄçÖº Øåî á�È
 !+ÈÅëÚ !+���È �Å+��Ä �� 3Ó�
 ÇêÅÛ�Ä �� ËÈ%�û��Ä ÌÅ+����ÅÈ �Å+��� åÞ,Ä �� ءçÖ

á�È$ �ÅÞà0Ä ÌÄáÚ$ ËûêÄ%È �Å�ä.Ä �ÅÞà¾ �� áÈ2 2$º Å�  Ë×�Å���Ä �Ï* ��â
 �3Þ �� Å#ÖÄåÞ¾ �Ï* )Ï�Ä ÕÂÅÏ��Ä )�� �%óÛ�� (ç�å��Ä ��ÛÏ�Ä  áÚ$ ËûêÄ%È
 ùÈÄåÎ Ùö%* )�ÅÏ�Ä ��ï�Ä$ �*çßÏ�Ä ÌÄáÚ$ ËûêÄ%È Å#�*çßÎ �Ò ÔÄåÞ0Ä ÌÄáÚ$

Å#÷�È �� ÇêÅÛ�Ä ءÄçÖº 

 

 

 Software (المكونات غير المادية )البرمجيات

 )�¾ ÇêÅÛ�Ä Õ�ÄåÈ �+ë�Î ���* Õ�ÄåÈ '�ëÎ$ ÇêÅÛ�Ä ËûêÄ%È Ë�áßÏë� Õ�ÄåÈ Õ�ÄåÉ�Ä �� �+�%�
Ë+�+ÉûÏ�Ä Õ�ÄåÉ�Ä )�ëÎ$ �áßÏë��Ä ËûêÄ%È �áßÏëÎ Õ�ÄåÈ$ ،�Åÿ��Ä 
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 نظام التشغيل .1

 �+�ïÏ�Ä ءáÈ Ë+��� �Ó� !��� ءÄàº �� ÇêÅÛ�Ä ���Î )Ï�Ä å�Ä$.Ä �� )�� (%ÏÛ* (ã�Ä �Åÿ��Ä %"
 �ÄáßÏêÄ$ ËîÅï�Ä )�� äÅ#ü0Ä$ËÉ�ó�Ä Ë�Ä%ûê.Ä (Hard Disk)Ë�å��Ä Ë�Ä%ûê.Ä$ (floppy 

disk) ÌÅ�%����Ä �*çßÏ�. 

�+�ïÏ�Ä �Åÿ� �%�*$ (operating system)  Ù�óÏ�$ ÆÅ��.Ä$ ÌÅ����Ä Õ�Å�� �Ó� Õ�ÄåÉ�Ä ÊäÄà¿È
، Õ�Å���Ä )�¾ Å"äå�*$ Õ�ÄåÉ�Ä  ã" �� å�Ä$.Ä �É�Ïë* %#
 .Í�åÏ�0Ä(processor)  ôå��Ä �ÿ�*$

�� Ë�ÅÉû�� $º ËÉ�ó�Ä Ë�Ä%ûê.Ä )�� �*çßÏ�� Å#�Åêä¿È �%�* �Ò ،Õ�Å���Ä �� ÕÂÅÏ��Ä ãÞ»*$ .ËîÅï�Ä )
 !�+�ïÎ á�� Å+�+ÎÅ�%Î$º ����Ä )
 ºáÉÎ$ ÇêÅÛ�Ä )
 Å�ÂÄà Êà%Ö%� �+�ïÏ�Ä Õ�ÄåÈ .Ë�ÈÅû�Ä Ë�,Ä )��

2 *��� �Ïê2Ä�Åء  Å�"3� ÊäÅ+ë�� ËÉë��ÅÈ �åÛ��Å� ÇêÅÛ�Ä �+�ïÎ �Åÿ�
.!��. 

 : من أشهر برامج التشغيل

o windows( 95,98,2000,XP) 

o LINUX 

o UNIX 

o DOS 

 البرامج التطبيقية .2

 ÌÅ�Å+É�Ä á�Ä%�$ Ë+�$åÏ��0Ä �$Äá×�Ä$ ÌÅ����Ä Õ�Å�� �Ó� ÇêÅÛ�Ä )�� ���Î )Ï�Ä Õ�ÄåÉ�Ä �� )"
  ã"$ .Êàá�Ï��Ä ùÂÅê%�Ä Õ�ÄåÈ$ ÆÅ��.Ä$ )ÉÏ���Ä åîÅ��Ä Õ�ÄåÈ$ ô$å��Ä ÌÄ$àº$ �å�Î Õ�ÄåÉ�Ä

�êÅÈ ÌÅ�+ÉûÏ�� �+�áßÏë��Ä &á� ( Microsoft Office). ومن أنواع البرمجيات التطبيقية 

o برمجيات النظام (System Software):  ÇêÅÛ�Ä )�� Êà%Ö%� Õ�ÄåÈ )"
 Êå� �$. ÇêÅÛ�Ä �ÄáßÏêÄ á��. !ÂÄåî á�� ËÉ�ó�Ä Ë�Ä%ûê.Ä )�� Åً�Éë� Ë�çß�$
 Ä 	*å�ÏÈ �%�� �º �Ó� Äã"$ .!�+�ïÏ� ÌÅ�%����Ä õ�È �ÅÞà¾ )�¾ å�.Ä ÔÅÏÛ* Å�Èä
 ��â !#ÈÅî Å�$ Í�åÏ�1� Ë�ò$ �Å�" �Å� Äâ¾$ ، !È Ë�óÏ��Ä Ë�ÈÅû�Ä �%�È ÇêÅÛ�
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��* . Äâ¾ 3Ó�
 .��â '�¾ ËÖÅÛ�Ä Í�à Å��� �Åÿ��Ä Õ�ÄåÈ )�¾ �Å#��Ä õ�È !
Åöº �
 �� ��Å�Ï�� ÇêÅÛ�� Ë+
Åö¾ Õ�ÄåÈ �+�ÛÎ )�¾ ÔÅÏÛ� Å��¿
 Ë�ÈÅû�Ä å++�ÏÈ Í��

Êá*á×�Ä Ë�ÈÅû�Ä. 

o البرمجيات التجارية (Commercial Ware):  �+É�� Ëö$å���Ä Õ�ÄåÉ�Ä åÉÏ�Î
Ä Õ�ÄåÈ Ë�%�×�� .Ë*äÅ×Î Õ�ÄåÈÇÏ��� (Microsoft office)   �+Éê )��

 ËÉêÅÛ��Ä$ �êå�Ä �Ó� ÌÅ�ÄáßÏê2Ä �� �2, Ë*äÅ×Ï�Ä Õ�ÄåÉ�Ä ØÅÏÎ$ .�ÅÓ��Ä
 ËóÞå� �%�Î Å� ÅÉ�Å� Ë*äÅ×Ï�Ä Õ�ÄåÉ�Ä$ .�3
.Ä å*åÛÎ$ �Å��.Ä ÊäÄà¾$
 ø$åï�Ä Ù+ö%Î �� ،Å#+�� �äÅ�Ï��Ä Ë�*åû�ÅÈ Å#�+È àå×� �� 2áÈ �áßÏë���

�Ä Ë��Ïß��Ä
ÈÅê Ùö%� %" Å�� ،Å#�ÄáßÏêÅÈ ËûÉÎå�. 

o برمجيات المشاركة (Shareware):  ËÈÅÏ�È ÊÄ%#�Ä$ �+×�åÉ��Ä �� á*á��Ä �%�*
 $º Í�åÏ�0Ä ËûêÄ%È �%�* á� Õ�ÄåÉ�Ä  ã" �*æ%Î$ .Å�Å×� ËÚÅÏ� �%�Î )Ï�Ä Õ�ÄåÉ�Ä
 �É� Í�%�Ä õ�É� ËÚÅÏ� �%�Î Å� ÊàÅ� Õ�ÄåÈ  ã"$ .Ì3×��Ä �� �æ%Î Ë�Ä%ûêÄ

åî àÄäº %�.�åï�Ä$ Ë�Ó�Ä )�� á�Ï�* Õ�ÄåÉ�Ä  ã" '�� �%óÛ�� �
á�Ä$.Å#ÂÄ
 á*áëÎ !+�� Ç×+
 Ë+É*å×Ï�Ä ÊåÏ��Ä á�È Õ�ÄåÉ�Ä �ÄáßÏêÄ )
 äÄå�Ïê2Ä �áßÏë��Ä

	�½��� �%êå�Ä 

o برمجيات بدون مقابل (Free Ware):  �$áÈ Ë�äÅï��Ä Õ�ÄåÉ� Ë#ÈÅï� �%�Î$
á*áëÎ ��%Ï* 2$ Å�Å×� �æ%Î )#
 �%êä  �� �+�%Ãë� �+��½��Ä õ�È$ Å#� �ÈÅ��

 õ�È ø$åïÈ Å÷*º )Î»Î Å#�¿
 ËÚÅÏ��Ä Õ�ÄåÉ�Ä )
 �ÅÛ�Ä %" Å��$ .Õ�Å�åÉ�Ä Êà%Ö
 ÊáÂÅ�È �+�áßÏë��Ä å�ï* )�� Åً�Å×� )�$.Ä Ýë��Ä �%�æ%* Å�Èä �*ä%û��Ä
2$ .�#×�ÄåÉ� Ë+�%�Å��Ä �%�Û�Ä ��È Õ�ÄåÉ�Ä  ã" %��½� ý�ÏÛ* Å� ÅÉ�Å�$ . Õ�Å�åÉ�Ä 

Õ�ÄåÉ�Ä  ã#� �*æ%Î $º Ýë�È Ù�ë*. 

o البرمجيات العامة(Public Ware) :  �Å��Ä �ÄáßÏê3� ËÚÅÏ� �%�Î Õ�ÄåÉ�Ä  ã"
Å#�ÄáßÏê2 �%êä áÖ%* 2، Å#�*á�Î$ Å#ßë� ���*$ Å�Å×� ËÚÅÏ� Å#�¾ (º. 

 

 الفرق بين التطبيقات والبرامج

�  :البرنامج. ÇêÅÛ�Ä !Ö%Î )Ï�Ä å�Ä$.Ä �� Ë�%�×� %" �� 	ï��Ä �Ó� �+�� Áî ���È �%�*
 Ë��È ÍÉÏ� )Ï�Ä$ ÌÅ�+��Ï�Ä �� Ë�%�×� !�º )�� Õ�Å�åÉ�Ä )
 å+��Ï�Ä Å÷*º ���* ÌÅê$å+��Ä Ë�Äæ¾$

 Ù+ÎÅ���Ä ËÚ%� )�� !ÏÈÅÏ�È �áßÏë��Ä �%�* ء)î (»
 Ë*åïÉ�Ä Ë���Ä �#�* 2 (ã�Ä$ ÇêÅÛ�Ä Å#�#�*
 ÇêÅÛ�Ä �%�* �º �É� )ÂÅ�Ó�Ä �Åÿ��Ä )�¾ �ÖåÏ* ã+��ÏÈ. 

 )�� ÊàÅ� �áßÏë��Ä Å#�#�* Êä%óÈ ÌÅ�%����Ä Ôåß*$ ÌÅ�Å+É�Ä Õ�Å�*$ ÌÅ�+��Ï�Ä ã��* ÇêÅÛ�Ä
Ë+�ä%�Ä Ë�ÈÅû�Ä $º ËîÅï�Ä. 


( � Äâ¾ .)�%+�Ä ����Ä�ÌÅ�%êå�ÅÈ ���Î Í  :التطبيقات �áßÏëÎ ÌÅ����Ä Õ�Å�� �Ó� Õ�ÄåÈ )"$
Í�� %� .Ë��Ïß��Ä ÌÅ�%êå�Ä ÌÅ�+ÉûÎ �áßÏëÎ �%ê ��»
  �áßÏëÎ �%ê ��»
 )�+ê%��ÅÈ ���Î

 ��� Õ�ÄåÈ áÖ%* . �Å��.Ä )
 �ÄáßÏê2Ä Ë�êÄ$ ËÉêÅÛ��Ä$ Ë�ÅÉû�Ä Õ�ÄåÈ �%�Î .)�+ê%��Ä Õ�ÄåÈ
Ë�àÅÉÏ�  ä%óÈ " ÌÅ�+ÉûÎ "$ " Õ�ÄåÈ " ÌÅÛ�ûó��Ä �ÄáßÏêÄ ���*$ .ËÈ%�û��Ä ôÄå�.Ä. 

 

 العمل مع نظام الويندوز ء بد

áÈ á�� ء '�á* Ùûê ä%#ÿÈ ��Å��Ä �3�0Ä �� á�»Ï� $ �3�0Ä Ë�ÏÎ 'ÏÚ �+�ïÏ�Ä �Åÿ� äÅÿÏ�Ä Å�+�� Ç×* åÎ%+É���Ä �+�ïÎ
 ýÚ3� ÇÏ���Ä Ùûê '�� åÎ%+É���Ä Õ�ÄåÈ $ åÎ%+É���Ä �� ��Å�Ï�ÅÈ Å#�3Þ �� �%�� ���È ËòÅÞ æ%�ä !+�� ÇÏ���Ä Ùûê

Ä Ë�åÚ ÇëÚ è$Å��Ä æÅ#Ö �� !È ��ÛÏ� �#ê à%Ö$ Å+�
Ä $  Å*à%�� ÇÏ���Ä Ùûê '�� åî½��Ä �åÛÏ* è$Å��� �áßÏë��
 .ÇÏ���Ä Ùûê �� '�� 
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 Êä»��ÄMOUSE  

 ÌÅ�ÂÅ��Ä ��� ����* .��Ä%�Ä )
 ÌÅ�ÂÅ��Ä �� ��Å�Ï�� �*á+�Ä �ÄáßÏêÅ� ËîÅï�Ä '�� åòÅ���Ä �� ��Å�Ï�� è$Å��Ä �ÄáßÏêÄ �Ï*
Å��¾ $º Å"å++�Î $º Å#ÛÏ
 $ºءÅ" ،Å+îº$ ء��* &åÞºåÎ%+É���Ä �+�ïÎ á�� è$Å��Ä ���Î �º Ç×* .Å"æÅ×�¾ �� ، ÙÉó* �Ò

ÄåÖ¾ �Å��0ÅÈ ء�ÅÓ��Ä �+Éê '�� .!�%�ê$ è$Å��Ä åî½� å#ÿ� '��$ Å#Ï�+ü$ '�� ÌÄå++�Ï�Ä õ�È ، ä$à �*áÉÎ ����*
è$Å��Ä äÄäæº ،è$Å��Ä åî½�� ËÉë��ÅÈ .Ô$àç��Ä å���Ä Ë�åê ùÉö $º ، å#ÿ� å++�Î ���* ،%ö$ �+ëÛÎ $º!Ú ، !�++�Î $º

Å�Òº )�Ïß+� ء :Å�"$ �++ë+Âä �*äæ '�� (%Û* $ .ËÈÅÏ��Ä 

  &åÞ.Ä ÌÄç+��Ä $º ÊåóÏß��Ä �ÂÄ%��Ä ôå�� !�áßÏë� (ã�Ä äç�Ä è$Å��Ä )
 ��*.Ä äç�Ä %" :(%�ÅÓ�Ä è$Å��Ä äæ
 .Õ�ÄåÉ�ÅÈ ËòÅß�Ä 

 Ïë� (ã�Ä äç�Ä è$Å��Ä Êç#Öº Ç��º )
 åë*.Ä äç�Ä %" :)ë+Âå�Ä è$Å��Ä äæ Å#� $ .Ô$àç��Ä å���Ä $º å���� !�áß
 :)"$ Êá*á� 	ÂÅü$ 

1-  .Å� ç�ä á*áÛÏ� !Î3
¾$ åë*.Ä è$Å��Ä äæ ù�ö àå���Ä å���Ä 

2-  . ËîÅï�Ä )
 àáÛ� ç�ä '�� �+Ï�*åê �+Ï+�ÅÏÏ� �+Îå� è$Å��Ä äæ Ì3
¾$ ù�ö Ô$àç��Ä å���Ä 

3- �Ä �Ò ËîÅï�Ä '�� Ëö$å���Ä à%�É�Ä áÚº '�� å+î»Ï�Ä ÇÛë�Ä ËÚÄæ¾ �Ò ��$ åë*.Ä è$Å��Ä äæ '�� å�Ïë��Ä ù�÷
.äç�Ä Ì3
¾$ 	�Ïß� �Å�� '�¾ è$Å��Ä 

 
�+�ïÏ�Ä Ë�ÿ�Ä �Ä%�Ä 

: '�� á�Ï�* Å� Å#��$ �+�ïÏ�Ä Ë�ÿ�2 ÌÅ�+�óÏ�Ä �� á*á��Ä ��Å�" 
1. �+�ïÏ�Ä �Åÿ� Å#��á* )Ï�Ä �+�áßÏë��Ä àá� 

o Single-user 

o Multi-User 

2.  �Åÿ� Å"ã��* )Ï�Ä �Å#��Ä àá�)�Ä%Ï�ÅÈ �+�ïÏ�Ä 

o single task 

o Multi-Task  
 
 

  -أساسيات واجهة نظام التشغيل ويندوز :
 ÇÏ���Ä ÙûêDesktop : 

 åÎ%+É���Ä �+�ïÎ á�È ��Å�º å#ÿÎ )Ï�Ä Ë+ë+Âå�Ä ËîÅï�Ä Ë�û�� ÇÏ���Ä Ùûê �Ó�* ، Ùûê ���*
ÌÄá�×� $º Õ�ÄåÈ ÙÏ
 á�� .!+�� ��Å��º Ë�$Äç� ����* Ùûë� åÎ%+É���Ä )
 ÇÏ���Ä ،  ã" �¿


Å+îº �ö$ Å÷*º ����* ً .ÇÏ���Ä Ùûê '�� å#ÿÎ ÌÄá�×��Ä$ Õ�ÄåÉ�Ä ء �Ó� ÇÏ���Ä Ùûê '��
Å����Ä .Å#+
 Ç�åÎ )Ï�Ä Ë+�+��ÅÈ Å#É+ÎåÎ$ ÌÄá�×��Ä$ Ì 

 ��êº �Å#��Ä ù*åî áÖ%* .�Å#��Ä ù*åî �÷* Ñ+ÛÈ Å�Å+Úº �ê$º ��ïÈ ÇÏ���Ä Ùûê 	*å�Î �Ï*$
)�ÅÛ�Ä Í�%�Ä )
 åÎ%+É���Ä '�� Å#�+�ïÎ �Ï* )Ï�Ä Õ�ÄåÉ�Ä å#ÿ*$ .ËîÅï�Ä ، Å�� .Å#�+È �*áÉÏ�ÅÈ Ù�ë*$

 ºáÈÄ" äç�Ä '�� Å÷*º (%ÏÛ* ،" ÌÄá�×��Ä$ Õ�ÄåÉ�Ä '�¾ �%ò%�Ä !�3Þ �� ����* (ã�Ä
 .åÎ%+É���Ä ÌÄàÄá�¾$ 
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 �Å#��Ä ù*åîTask bar : 
 )�Ïß* �º ���* (ã�Ä ÇÏ���Ä Ùûê �3ßÈ .ËîÅï�Ä ��êº )
 à%Ö%��Ä �*%û�Ä )�
.Ä ù*åï�Ä %"

Ää$ ءËÚ%Ï���Ä ã
Ä%��Ä ، ù*åî �¿
 .Í�%�Ä �Ä%ø Å+Âå� �%�* Å� ÅÉ�Å� �Å#��Ä 
 
 
 

 :Ë+ë+Âä �Åë�º ËÒ3Ò �� �Å#��Ä ù*åî �%�Ï* 
 ºáÈÄ' äç�Ä  ،' .'ºáÈÄ' Ë�ÂÅ��Ä ÙÏ�* (ã�Ä 
 * (ã�Ä ùê$.Ä �ë��Ä Ë�*åûÈ Å#�+È �*áÉÏ�Ä Ë+�Å��¾ Ù+Ï*$ ËÚ%Ï���Ä ÌÅ����Ä$ Õ�ÄåÉ�Ä å#ÿ

.Ë�*åê 

çÖ ء Õ�ÄåÉ�Ä õ�È Ë�ÅÚ '�¾ å+ïÎ )Ï�Ä )Êå+�ó�Ä ä%ó�Ä( æ%�ä$ Ë�Åê ��÷Ï* (ã�Ä ÌÅ�3�0Ä
È$ ÌÄàÄá�¾ õ� .åÎ%+É���Ä 
 

 �Å#��Ä ù*åî )
 Õ�Å�åÈ ôå��Task bar : Ë+�ÅÏ�Ä ÌÄ%ûß�Ä �ÉÎÄ-  
1 .ºáÈÄ Ë�ÂÅ��Ä '��º )
 !öå� á*åÎ (ã�Ä Õ�Å�åÉ�Ä �%
 ��*.Ä è$Å��Ä äçÈ å��Ä . 
2( "ºáÈÄ" Ë�ÂÅ��Ä '�¾ Ë
Åö¾ äÅÏß� )�ÅÏ�Ä ��ï�Ä )
 Å�� å#ÿÎ )Ï�Ä Ë+�å��Ä Ë�ÂÅ��Ä �� .Pin to 

Taskbar  . ) 
  

 
 
3 .ºáÈÄ Ë�ÂÅ��Ä )
 �òÅ��Ä ùß�Ä '��º Ë�û���Ä )
 Ë
Å÷��Ä åòÅ���Ä Ë�ÂÅ� )
 Õ�Å�åÉ�Ä ôå� �Ï+
 . 
 

 �Å#��Ä ù*åî �� Õ�Å�åÈ �ãÚTask bar : Ë+�ÅÏ�Ä ÌÄ%ûß�Ä �ÉÎÄ-  
1 .ºáÈÄ Ë�ÂÅ��Ä '��º )
 !
ãÚ á*åÎ (ã�Ä Õ�Å�åÉ�Ä �%
 ��*.Ä è$Å��Ä äçÈ å��Ä . 
2 �� .( "ºáÈÄ" Ë�ÂÅ��Ä '�¾ Ë
Åö¾ äÅÏß� å#ÿÎ )Ï�Ä Ë+�å��Ä Ë�ÂÅ��Äunpin this program from 

Taskbar ) 
  

 
3 �Å#��Ä ù*åî Õ�Å�åÉ�Ä �ãÚ �Ï* .Task bar  
 

 ( Startالقائمة ) 
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 Å#�. Ë�ÂÅ� Å#+�� 
�û*$ .!ÎÄàÄá�¾$ !ÎÄá�×�$ åÎ%+É���Ä Õ�ÄåÈ '�¾ Ë+ë+Âå�Ä ËÈÄ%É�Ä "ºáÈÄ" Ë�ÂÅ��Ä á�Î
ÌÄäÅ+ÏÞ2Ä �� Ë�ÂÅ� å
%Î ،'ºáÈÄ' Ë��� �� $áÉ* Å��$ ،áÉ� !+�¾ ��Ï�Î (ã�Ä �Å���Ä )" Ë�ÂÅ��Ä  ã" á�Î ء

Å+î.Ä �+�ïÎ ء �ÄáßÏêÄ ����*.Å#ÛÏ
 $ºÈ �Å+��� "ºáÈÄ" Ë�ÂÅ��Ä:Ë�ÂÅï�Ä Ëûï�.Ä  ã#-  
 

áÈ • ء Õ�ÄåÉ�Ä �+�ïÎ 
 �ÄáßÏê2Ä Ë�ÂÅî ÌÄá�×��Ä ÙÏ
 • 

 Õ�ÄåÉ�Ä$ ÌÄá�×��Ä$ ÌÅ����Ä �� ÑÛÉ�Ä • 
 åÎ%+É���Ä ÌÄàÄá�¾ ùÉö • 

 �+�ïÏ�Ä �Åÿ� �%Ú ÌÅ�+��Î '�� �%óÛ�Ä •Windows  
 åÎ%+É���Ä �+�ïÎ �Å�*¾ • 

 �� Ô$åß�Ä �+×ëÎ •Windows åÞ¸ �áßÏë� ÆÅëÚ '�¾ �*áÉÏ�Ä $º 
 

 Windows7الشروع في استخدام القائمة "ابدأ": ]اكتب عنوان المستند[ 
  

'ºáÈÄ' Ë�ÂÅ��Ä ÙÏ�� ، '�� ù�öÄ $º .ËîÅï�Ä �� ��*.Ä ��å�Ä ��êº )
 à%Ö%��Ä ºáÈÄ äç�Ä �%
 å��Ä
 äÅ�î ØÅÏ��Windows  . )�ÅÏ�Ä ��ï�Ä )
 Å�� ÄáÈº Ë�ÂÅ� å#ÿÏ
 .Ù+ÎÅ���Ä ËÚ%�È à%Ö%��Ä 

 

 
ÄçÖº ËÒ3Ò �� "ºáÈÄ" Ë�ÂÅ��Ä �%�ÏÎ ء :Ë+ë+Âä 

 ç×�Ä ôå�* ء ���* .åÎ%+É���Ä '�� Êà%Ö%��Ä Õ�ÄåÉ�Ä �÷Î Êå+�ò Ë�ÂÅ� å+É��Ä ��*.Ä
 åÎ%+É���� Ë��ó��Ä Ë�åï��Ë�ÂÅ��Ä  ã" ñ+óßÎ ،)�ÅÏ�ÅÈ$ ، .	�Ïß* �º Å"å#ÿ�� ���*

 .Õ�ÄåÉ�� Ë��Å� Ë�ÂÅ� ôå� '�¾ Õ�ÄåÉ�Ä Ë
Å� �%
 å���Ä (à½* 
 

 ç×�Ä ��êº ÑÛÈ �Èå� áÖ%* ء��*.Ä ، Êà%Ö%��Ä ÌÅ����Ä$ Õ�ÄåÉ�Ä �� ÑÛÉ�ÅÈ �� Ù�ë*
 ËÈÅÏ� ËûêÄ%È åÎ%+É���Ä '�� .ÑÛÉ�Ä ÌÅÛ�ûó� 
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 ç×�Ä Ù+Ï* ءÄ Ë+�Å��¾ åë*.Ä Ë�ÂÅî ÌÄç+��Ä$ ÌÄàÄá�0Ä$ ÌÅ����Ä$ ÌÄá�×��Ä '�¾ �%ò%�
 �Å���Ä !�º Å�� .�ÄáßÏê2Ä �� Ô$åß�Ä �+×ëÏ� !+�¾ ��Ï�Î (ã�ÄWindows  �+�ïÎ �Å�*¾ $º

 .åÎ%+É���Ä 
 
 
  
  
  
  
  
  
  
  
  
  

 فتح البرامج من القائمة "ابدأ": 
 ÙÏ��$ ."ºáÈÄ" Ë�ÂÅ��� Å�%+î åÓ�.Ä ÌÅ�ÄáßÏê2Ä �� �*á� åÎ%+É���Ä '�� ËÏÉÓ��Ä Õ�ÄåÉ�Ä ÙÏ
 á�*

ç×�Ä )
 à%Ö%� Õ�Å�åÈ ء"ºáÈÄ" Ë�ÂÅ��Ä �� ��*.Ä ، Ë�ÂÅ��Ä �3�¾ �Ï*$ Õ�Å�åÉ�Ä ÙÏ
 �Ï* .!�%
 å��Ä
 ".ºáÈÄ" 

 
 á*åÎ (ã�Ä Õ�Å�åÉ�Ä ��Å�º å#ÿ* �� Äâ¾ ،º Õ�ÄåÉ�Ä Ë
Å� �%
 å��Äç×�Ä ��ê ءç×�Ä ôå�* .��*.Ä ء

(á×Èº Ç+ÎåÏÈ Êà%Ö%��Ä Õ�ÄåÉ�ÅÈ Ë�*%ø Ë�ÂÅ� ��*.Ä ، .ÌÄá�×��Ä �� Ë�ÂÅ�È Ë�%ÉÏ� 
Õ�ÄåÉ�Ä æ%�ä áÚº �%
 å���ÅÈ$ ، áÖ%* ÄâÅ� �,Ä$ ."ºáÈÄ" Ë�ÂÅ��Ä �3�¾$ Õ�Å�åÉ�Ä Äã" �+�ïÎ �Ï*

ÌÄá�×��Ä �ÞÄà ؟Ë�Û���Ä Õ�ÄåÉ�Ä �%
 å��Ä .Õ�ÄåÉ�Ä �� á*ç� ،���ÅÓ��Ä �+Éê ' ، Ë�ÂÅ� å#ÿÏ�
 á�� Å#Îá"Åî )Ï�Ä Õ�ÄåÉ�Ä '�¾ Êà%��� .!ÛÏ�� Õ�Å�åÈ (º �%
 å��Ä .á�×��Ä Äã" )
 Ëü%�Û��Ä Õ�ÄåÉ�ÅÈ

Êå� �$º "ºáÈÄ" Ë�ÂÅ��Ä ÙÏ
 ، .Ë�ÂÅ��Ä ��êº �� Æå��ÅÈ 	�ß�Ä �%
 å��Ä 
 

Õ�ÄåÉ�Ä áÚº !È �%�* Å�� Äá�»Ï� ��Î �� Äâ¾ ،º  ç�ä �%
 åî½��Ä �åÛ
ãÂá�� .!�êÄ $ ، �Èå� å#ÿ*
É�Å� (%ÏÛ* Äã#� 	ò$ '�� Å�ÅÓ��Ä �+Éê '�� .Õ�Å�åÉ�Ä ، Äã" )
 Ëü%�Û��Ä Õ�ÄåÉ�ÅÈ Ë�ÂÅ� å#ÿÏ�

Êå� �$º "ºáÈÄ" Ë�ÂÅ��Ä ÙÏ
 á�� Å#Îá"Åî )Ï�Ä Õ�ÄåÉ�Ä '�¾ Êà%��� .!ÛÏ�� Õ�Å�åÈ (º �%
 å��Ä .á�×��Ä ،
.Ë�ÂÅ��Ä ��êº �� Æå��ÅÈ 	�ß�Ä �%
 å��Ä 

 
 Äâ¾Õ�ÄåÉ�Ä áÚº !È �%�* Å�� Äá�»Ï� ��Î �� ،ãÂá�� .!�êÄ $º  ç�ä �%
 åî½��Ä �åÛ
 ، �Èå� å#ÿ*

�Å� (%ÏÛ* ÅÈ�ÅÓ��Ä �+Éê '�� .Õ�Å�åÉ�Ä Äã#� 	ò$ '�� ، ôå� '�¾ "ËÉêÅÛ�Ä" '�¾ ÊäÅî0Ä (à½Î
Äàº" :Ë�Åêå�Ä  ã" ءº Ë�áß�Ä  ã" ���Î ".ËîÅï�Ä '�� ËÉêÅÚ �ÄáßÏêÅÈ Ë+êÅêº Ë+ÈÅëÚ ÌÅ�#� �� Å÷*

 ".ºáÈÄ" Ë�ÂÅ��Ä �� åë*.Ä Ç�Å×�Ä )
 Êà%Ö%��Ä åòÅ���Ä 
Í�%�Ä ä$å�È !�º ýÚ3Î Å�Èä ، .�+ÉÉë� ��â ÐáÛ*$ ."ºáÈÄ" Ë�ÂÅ��Ä )
 Êà%Ö%��Ä Õ�ÄåÉ�Ä �ÂÄ%� å+�ÏÎ

�$.Ä ،Êá*áÖ Õ�ÄåÈ Í+ÉÓÎ á�� !�º %" ،)�ÅÓ�Ä ."Õ�ÄåÉ�Ä Ë
Å�" Ë�ÂÅ��Ä '�¾ Å#Ï
Åö¾ �Ï* ، )
 Å#�ö%È
ç×�Ä ء*.Ä Å#�áßÏëÎ )Ï�Ä Õ�ÄåÉ�Ä 'ºáÈÄ' Ë�ÂÅ��Ä 	ï�Î .�åêº Ë�*åûÈ Å#+�¾ �%ò%�Ä )
 �Îá�Åë�� ��
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åÉ�º ��ïÈ ، �%�Î$ 
 
 

 : ºáÈÄ Ë�ÂÅ��Ä '��º )
 Õ�Å�åÈ ôå�� 
1 .ºáÈÄ Ë�ÂÅ��Ä '��º )
 !öå� á*åÎ (ã�Ä Õ�Å�åÉ�Ä �%
 ��*.Ä è$Å��Ä äçÈ å��Ä . 
2 Ë
Åö¾ äÅÏß� å#ÿÎ )Ï�Ä Ë+�å��Ä Ë�ÂÅ� .( "ºáÈÄ" Ë�ÂÅ��Ä '�¾Pin to Start Menu  . ) 
   

 
  
3 .ºáÈÄ Ë�ÂÅ��Ä )
 �òÅ��Ä ùß�Ä '��º Ë�û���Ä )
 Ë
Å÷��Ä åòÅ���Ä Ë�ÂÅ� )
 Õ�Å�åÉ�Ä ôå� �Ï+
 . 
 

 حذف برنامج في أعلى القائمة ابدأ: 
1 .ºáÈÄ Ë�ÂÅ��Ä '��º )
 !
ãÚ á*åÎ (ã�Ä Õ�Å�åÉ�Ä �%
 ��*.Ä è$Å��Ä äçÈ å��Ä . 
2 .( "ºáÈÄ" Ë�ÂÅ��Ä '�¾ Ë
Åö¾ äÅÏß� å#ÿÎ )Ï�Ä Ë+�å��Ä Ë�ÂÅ��Ä ��unpin from Start Menu  )

 å�.Ä $º (Remove from Start List) 

 

 
3 .ºáÈÄ Ë�ÂÅ��Ä )
 �òÅ��Ä ùß�Ä '��º Ë�û���Ä )
 Ë
Å÷��Ä åòÅ���Ä Ë�ÂÅ� )
 Õ�Å�åÉ�Ä �ãÚ �Ï* . 
 

 مربع البحث: 
 
 ' �åû�Ä áÚº %" 'ÑÛÉ�Ä �Èå�Ë�Â3� åÓ�.Ä Å+îº �� ÑÛÉ�� ء.åÎ%+É���Ä '�� Êà%Ö%� 

ùÉ÷�ÅÈ åòÅ���Ä ��%� �#* 2 ، �� �Ï* Ñ+Ú ÌÄá�×��Ä Ë
Å�$ Õ�ÄåÉ�Ä )
 ÑÛÉ�Ä 'ÑÛÉ�Ä' �Èå� �3Þ
 Ë�ÂÅï�Ä ��Ä%��Ä$ ÇÏ���Ä Ùûê$ '�+ê%��Ä$ ä%ó�Ä$ ÌÄá�Ïë��Ä ��÷Ï* (ã�Ä( )óßï�Ä á�×��Ä )

 á+�Ä%��Ä$ Ëü%�Û��Ä Ë*ä%��Ä �ÂÅêå�Ä$ )�$åÏ��0Ä á*åÉ�Ä �ÂÅêä )
 ÑÛÉ�ÅÈ  Å÷*º �%�*$ .)&åÞ.Ä

 ÌÅ#Ö$ .�ÅóÎ2Ä 
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 'ºáÈÄ' Ë�ÂÅ��Ä )
 ÑÛÉ�Ä �Èå� 
'ÑÛÉ�Ä' �Èå� �ÄáßÏê2 ،Å�Òº . 2$º �Èå��Ä �ÞÄà å���Ä �ç�* 2 .ËÈÅÏ��Ä ºáÈÄ$ 'ºáÈÄ' Ë�ÂÅ��Ä ÙÏ
Ä ء

ËÈÅÏ��Ä ،ç×�Ä )
 ÑÛÉ�Ä �Èå� �%
 ÑÛÉ�Ä ÕÂÅÏ� å#ÿÎ ء $º Õ�Å�åÉ�Ä å#ÿ+ê'.ºáÈÄ' Ë�ÂÅ��Ä �� ��*.Ä
 .ÑÛÉ�Ä ÕÂÅÏ� �� Ë×+Ï�� á�×��Ä $º 	���Ä 

 
 ÌÅ
$ãÛ��Ä Ë�êRecycle Bin  

á�×� $º 	�� �ãÛÈ �%�Î Å�á�� ، Å+ÂÅ#� Ë�+�Û�Ä )
 !
ãÚ �Ï* 2 !�¿
-  Ë�ê '�¾ 2$º Ç"ã* !���$
)î Äã" .ÌÅ
$ãÛ��Ä ءá+Ö ،�$ãÛ� 	�� '�¾ ÔÅÏÛÎ ��º Ìäå�$ �*ºä Ìå+� Äâ¾ ��. ، ����*

 .&åÞº Êå� !ÎàÅ�ÏêÄ 
  

 
 

 )äÅë+�Ä '�¾( ËÃ�Ï�� �%�Î Å�á��$ )�+�+�Ä '�¾( Ë�äÅ
 �%�Î Å�á�� "ÌÅ
$ãÛ��Ä Ë�ê 
 ًً&åÞº Êå� Ë
$ãÛ��Ä åòÅ���Ä '�¾ ÔÅÏÛÎ �� ��º �� Äá�»Ï� Í�� Äâ¾ ، Ë�ê �*å�Î ����*

 åòÅ���Ä �ãÚ '�¾ ��â (à½+ê .ÌÅ
$ãÛ��Ä .Å#�áßÏëÎ Í�� )Ï�Ä ðå��Ä ËÚÅë� ÊàÅ�ÏêÄ$ Å+ÂÅ#� 
 
 

 ÌÅ
$ãÛ��Ä Ë�ê �� ÌÅ����Ä àÄàåÏêÄ 
åÎ%+É���Ä �� 	�� �ãÛÈ �%�Î Å�á�� ، !�*çßÎ �Ï* Ñ+Ú "ÌÅ
$ãÛ��Ä Ë�ê" '�¾ ��Ä%�Ä )
 ��Ï�* %#


 
*åûÈ Å#
ãÚ �Î )Ï�Ä ÌÅ����Ä ÊàÅ�Ïê2 Ëòå��Ä Ù+Ï* Å�� ."ÌÅ
$ãÛ��Ä Ë�ê" �Äå
¾ �Ï* �º '�¾ ÅÏ�½�
 .Ë+�ò.Ä Å#��Ä%� '�¾ Å#ÎàÅ�¾$ »ûß�Ä 

 
1Ä . .ÇÏ���Ä Ùûê '�� ÌÅ
$ãÛ��Ä Ë�ê �%
 Ô$àç��Ä å���ÅÈ 'ÌÅ
$ãÛ��Ä Ë�ê' ÙÏ
 
2ÄåÖ¿È �� . ء :)�* Å�� áÚÄ$ 

	�� ÊàÅ�Ïê2 • ، ��*.Ä è$Å��Ä äçÈ !�%
 å��Ä ، " �%
 å��Ä �ÒRestore  .،" ��ï�Ä )
 Å��
 )�ÅÏ�Ä 

  

 
 

	�� ÊàÅ�Ïê2 • ،!�%
 å��Ä ،åó���Ä Äã" ÊàÅ�ÏêÄ �%
 å��Ä �Ò ، )
 Å�� .ÌÄ$à.Ä ù*åî ��
 )�ÅÏ�Ä ��ï�Ä 

ÌÅ����Ä Ë
Å� ÊàÅ�Ïê2 • ،	�� (º á*áÛÎ �á� �� á�»Î ، " �%
 å��Ä �ÒRestore all  ،" ÊàÅ�ÏêÄ Ë
Å�
 .ÌÄ$à.Ä ù*åî �� åòÅ���Ä 

 
 .åÎ%+É���Ä '�� )�ò.Ä Å#��%� '�¾ ÌÅ����Ä ÊàÅ�ÏêÄ �Ï+ë
 

Eng
.w

al
ee

da
lk
ur

di



  

 
  
 

 ÌÅ
$ãÛ��Ä Ë�ê �� Ë�ÂÄà Ë�óÈ ÌÅ����Ä �ãÚ 
  ã" Å#�ÏÛÎ Í�Å� ÍÈÅÓ�Ä ðå��Ä '�� ËÚÅë� Ë*º �� ÊàÅ�Ïê2Ä$ åÎ%+É���Ä �� Å+ÂÅ#� ÌÅ����Ä Ë�Äæ0

ÌÅ����Ä ، Ë�ê' �� Å#
ãÚ Ç×* 'ÌÅ
$ãÛ��Ä Ë�ê' �� Ë*àå��Ä ÌÅ����Ä �ãÚ äÅ+ÏÞÄ ���* .'ÌÅ
$ãÛ��Ä
Äå×�ÅÈ �� .�ÅÛ�Ä )
 Å#�� Å#�*å�Î $º ء )�ÅÏ�Ä 

 
1 .ÇÏ���Ä Ùûê '�� ÌÅ
$ãÛ��Ä Ë�ê �%
 Ô$àç��Ä å���ÅÈ 'ÌÅ
$ãÛ��Ä Ë�ê' ÙÏ
Ä . 
2ÄåÖ¿È �� . ء :)�* Å�� áÚÄ$ 

Å+ÂÅ#� áÚÄ$ 	�� �ãÛ� • ، è$Å��Ä äçÈ !�%
 å��Ä ��*.Ä ، '�ãÚ' �%
 ù�öÄ �Òdelete ، ��â á�È$
 .

Ä%� �%
 å��Ä 

 

 
 
 ÌÅ����Ä Ë
Å� �ãÛ� • ،ÌÄ$à.Ä ù*åî )
 ،"ÌÅ
$ãÛ��Ä Ë�ê" �Äå
¾ �%
 å��Ä ، .��� �%
 å��Ä �Ò 
  

 
:Ù+��Î-  Å#�%
 ��*.Ä è$Å��Ä äçÈ å���Ä 
*åø �� Å#ÛÏ
 �$áÈ . 'ÌÅ
$ãÛ��Ä Ë�ê' �Äå
¾ ����* ، �Ò

 ÌÅ
$ãÛ��Ä Ë�ê �Äå
¾ �%
 å���Ä 
 
 

Eng
.w

al
ee

da
lk
ur

di



 
 
*åø �� 'ÌÅ
$ãÛ��Ä Ë�ê' '�¾ !�Åêä¾ �$à åÎ%+É���Ä �� Ë�ÂÄà Ë�óÈ ÌÅ����Ä áÚº �ãÚ ����* •

	���Ä �%
 å���Ä ،�%
 ù�÷�Ä �Ò (Shift+Delete.) 
 
 

 : My computerجهاز الكمبيوتر 

 

�å��Ä ðå��Ä ÌÅ*%ÏÛ� åÎ%+É���Ä æÅ#Ö å#ÿ* ،ÍÈÅÓ�Ä ðå��Ä ÌÅ*%ÏÛ� ، ðÄå�.Ä �åÛ� $
Ëø%�÷��Ä ، Ë�Éï�Ä ðÄå�º ÌÅ�åÛ� $"åÎ%+É���Ä æÅ#Ö" ÙÏ�� ��ÛÏ�Ä ËÚ%� $ ،ºáÈÄ �%
 å��Ä ، ��$

Ä �Åÿ��Ä )
 á*á×�Ä æ$á�*$ �Åÿ� )
 åÎ%+É���Ä æÅ#Ö �%
 å��Ä �Ò á*á×�Å�ÞÄ �ç�ä äÅ#üÄ $º ء *��
 �ÅÉÎÅÈ ÇÏ���Ä Ùûê '�� �� åÎ%+É���Ä æÅ#Ö 

 

 Õ�ÄåÉ�Ä Ë
Å� Ë�ÂÅ�All Programs : 

 Å÷*º $ åÎ%+É���Ä æÅ#Ö '�� Å"àÄá�Ä �Î )Ï�Ä Õ�ÄåÉ�Ä �+�×� ÌÄäÅóÏÞÄ (%ÛÎ Ë�ÂÅ� �� ÊäÅÉ�
 �Åÿ� ÌÅ�+ÉûÎ $ Õ�ÄåÈ �+�Ö �+�ïÏ�Ä 

 

 :ÌÄá�Ïë��Ä á�×�MY Documents  

  $ ä%ó�Ä ý�Ú Å÷*º ���* $ �+�� �áßÏë�È ËòÅß�Ä ÌÅ����Ä Ë
Å� ý�Ú !+
 �Ï* á�×� �� ÊäÅÉ�
 ���* ËòÅß�Ä Ë+Î%ó�Ä ÌÅ����ÄÅ�ÞÄ ء . ÇÏ���Ä Ùûê '�� $ �� ÌÄá�Ïë��Ä á�×� äÅ#üÄ $ 
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 ��ÛÏ�Ä ËÚ%�Control Panel : 

  

 å++�Ï� Å#�ÄáßÏêÄ �Ï* )Ï�Ä $ Ëóóß��Ä ÌÄ$à.Ä �� á*á��Ä '�� (%ÛÎ Êã
Å� �� ÊäÅÉ� ��ÛÏ�Ä ËÚ%�
 Ë+�+� $ æ$á�*$ ��� Ë�*åø �� ��×Î )Ï�Ä ÌÄàÄá�0Ä ùÉö )
 ÌÄ$à.Ä  ã" á�ÅëÎ $ !�%�ê

:��ÛÏ�Ä ËÚ%� ÙÏ�� . Å�ÅÏ�Ä åÓ�º åÎ%+É���Ä �ÄáßÏêÄ 

 

1Ò Ë+�+ê3��Ä ºáÈÄ Ë�ÂÅ� ÙÏ���ßـــ.  � .��ÛÏ�Ä ËÚ%� äÅÏ 

2 �Åÿ� )
 ËòÅÞ ôå� Ë�*åø )" $ ÌÅÃ
 ��ïÈ Êã
Å��Ä åòÅ�� å#ÿÎ ��ÛÏ�Ä ËÚ%� Êã
Å� ÙÏ
 á�� .
 �+�ïÏ�ÄWindows XP  �+�* '�� Êà%Ö%��Ä Êã
Å��Ä �� Ë+�+ê3��Ä ôå��Ä Ë�*åø '�¾ �*áÉÏ��

 Ë+�+ê3��Ä ôå��Ä Ë�*åø '�¾ �*áÉÏ�Ä '�� ù�÷� Êã
Å��Ä Ë#ÖÄ$ 

 

�ïÏ�Ä �Å�*¾ �+Shut Down  : 

 Å#Ï�Ä á�� Ç×* �3 ءÞ �� ��â �Ï* $ ��¸ ��ïÈ åÎ%+É���Ä æÅ#Ö �3�¾ åÎ%+É���Ä æÅ#×È ����Ä
 äæ '�� åë*.Ä è$Å� äçÈ ù�÷�Ä åÎ%+É���Ä �+�ïÎ �Å�*¾ å�º äÅ+ÏÞÄ �Ò ºáÈÄTShut 

Down"25T 25  �%
 å���Ä á��$ ��¸ ��ïÈ åÎ%+É���Ä æÅ#Ö �3�¾ �Ï* äç�Ä Äã" '�� å���Ä á��
 "
" äç�Ä äÄ%×È à%Ö%��Ä �#ë�ÄTShut Down ÌÄäÅ+Þ '�� (%ÏÛÎ )Ï�Ä �ÂÄ%��Ä &áÚ¾ ôå� '�¾ "

: )"$ Ë+
Åö¾-  ( �+�áßÏë��Ä �*áÉÏ�Switch user  ، )( Ô$åß�Ä �+×ëÎLog off  ، ) ÊàÅ�¾
 " �+�ïÏ�ÄRestart"  ، " ÌÅÉê2ÄHibernate  ،" " ���lock  �%�ë�Ä " " ،Sleep " 

 

 

 

 •SwitchUser :- *áÉÎ (Ä �)�áßÏë��ã�Ä (É+Ä )��ÄåÉ� ÔËÚ%Ï�� ��Þ ÄÊã
Å�� á*á×�Ä �áßÏë��� á�� 
+×ëÎ ��%Þá  ÏÛ &#Ï�+ (�Ä ���� �+×ëÎ% �Ö$åß  � (à%�+  �áßÏë��Ä$.Ä �+×ëÏ� ��%Þá  Êå� 

 &åÞº 
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  •Log Off :- +×ëÎ(Ä �) Ô$åß�ã�Ä (��+ �+�×Ä ��ÄåÉ� Ô�É*%Ä (ËÉêÅÛ� Ë��Ïï� ÏÚ &+ûÏë+ �
áßÏë�º ��åÞ �+×ëÏ ��%Þá¾   .Å#+� 

  •Lock :- ) ����Ä(ã�Ä (�+ (º ��ßï ð�Ä �%Þá� �Å�ÓÏêÅÉء Åßî.ÄÄ ðÞå�� ð#� �%Þá�ÅÉ �
Ä '�Ä .ËÉêÅÛ� 

  •Restart :- ÊàÅ�º( )�+�ïÏ�Äã�Ä (�%+Ä �ËÉêÅÛ�  �Ò á+�* Å#�+�ïÎ 

  •Shut Down:- (Å�*¾ � )�+�ïÏ�Å+Ú Ð��Ï �+�×Ä ��ÄåÉ� Ô�%ÏÎ%Ä �ËÉêÅÛ� �Ä � ���� 

  •Sleep :- ) �%�ë�Ä (+Ú Ðÿ�Û+ Åÿ�Ä �+�ïÏ� �Ë#ÖÄ% ���Ä �É*% '�� (Ë�ÅÛ  �%�ë�Ä 

  

  

  

 æ$á�*$ ÇÏ���ÅÛûê '�� ) ÌÄá�Ïë��Ä + ��ÛÏ�Ä ËÚ%� + åÎ%+É���Ä ( ÌÅ�%�*º äÅ#ü¾ Ë�*åø7  

 æ$á�*$ Çó�Î á�È7  "Ë�%�*¾ ù�
 ýÚ3� Ñ+Ú ..  Å�àº ��ï�Ä )
 Å�� ÇÏ���Ä Ùûê Ë#ÖÄ$ å#ÿÎ
Recycle Bin  " 

  

  

 æ$á�*%�Ä )
 ÇÏ���Ä Ùûê '�� ÌÅ�%�*0Ä äÅ#ü0$7: Ë+�ÅÏ�Ä ÌÄ%ûß�Ä �ÉÏ�-  

1 ºáÈÄ Ë�ÂÅ� �� .Start  

2 ÇÏ���Ä Ùûê '�� Å"äÅ#ü¾ Æ%�û��Ä Ë�%�*0Ä '�� ��*.Ä è$Å��Ä äçÈ ù�öÄ . 
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3 . Show on Desktop �Ò äÅÏß� å�.Ä 

 

  

 àáÛ� %" Å�� Í�%�Ä $ Ë�Åë�Ä ôå�Î $ �Å#��Ä ù*åî '�� Ë+��ä Ë�Åê ôå� :Ë�Åë�Ä äÅ#ü¾
 $ Ë+�ÞÄá�Ä åÎ%+É���Ä Ë�Åê ËûêÄ%È å+î»Ï�Ä ���* ùÉ÷� Å#�%
 å���Ä $ Ý*äÅÏ�Ä ôå�� Ë�Åë�Ä '�¾

 " '�� å��� åÎ%+É���Ä Í�$ å++�Ï� $ .Ý*äÅÏ�Ä $ Í�%�Ächange date and time setting Å�� "
 .  Å�àº ��ï�Ä )
 

 

 

 ã
Ä%��ÄWindows  

���Ä ��� Ä :â
Ä$�� 

 �+Ï+�ÅÏÏ� �+Îå�� Ë�%�*.Ä '�� äÅë+�Ä è$Å� äçÈ ù�÷�Ä á��Double click  !Îã
Å� å#ÿÎ
+ë+Âå�Äــ Ë�� àÏ
 Ø�Å�åÉº Ô��$º �á�×�$ ،�å#ÿ*Ä '� ËîÅï� )
Èå�º �ë* äÅø¾ $ '� ��ã� Êã
Å�É

 �+�ïÏ�Ä �Åÿ� )�ê �Åÿ�ÈWindows  $º Õ�Å�åÈ (º �. Êã
Å� ��ïÈ ÙÏ�* !ÛÏ
 á�� ç�ä
ÅÖÅ�#��$ء.�+�ïÏ�Å�Åÿ��êÄ 

 

ÄæÖºء :Êâ
Å��Ä 

�å�ÅÈ �� �º �Å*%ÏÛ� Ì� �ã
Å� ÊÏßÎ 	��� Êã
Å� Ä '�Ä&åÞ، 2¾ º �Ë
Å� ã
Ä%��Ä åÏïÎ �� (�É ô
ÄÅ+î.ء �ïÈ�Å� � ��$.+ÈÄ  ã" �Å+î. ءË�åÏï��Ä ، Å�$à ã
Ä%��Äå#ÿÎ '��ûëÄ Øã�Ä ÇÏ��� (Ó�+ �
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���Ä Ë�û��Ä � Ë+ë+Âå�Ä �� Ë
Åö0ÅÈ$ .ËîÅï� '�Ä��ã ،%ÏÛÎ Ë+É�Å� ( ã
Ä%��Ä '����Ä èÄçÖ. ء
 .Ë+êÅê.Ä 

 

 

1- ç×�Ä2 ءÄ �� åë+çÖ%" Êã
Å��Äء ��Ï�Ä �%ò%��Ä '�Ä �ÅÉÏ��� ÌÄá�×��Ä% ÌÅ+���%Ä ÌÛÉ� Ð
ÄËü%�Û�� Ú$ 'ÎË
Å� Äå�.ÄÄ ð .ËÏÈÅÓ����*Ä �Äå�Ïê2" åÎ%+É���Ä "�+ê%Î Å÷*Ä ôÄá�×�� Ì

Äá�×��Ä%Ä Ì ."Ë+�å�� 

 

2- : 	�ß�Ä$ �Å�.ÄÄäæ- áßÏêÄÄ �äç� � �Å�.Ääç�Ä$ 	�ß�ÄÅ�Ï�3 '�Ä �Äá�×�Ä Ì$ ÅÉÏ��Ä ÌåÞ &
�� ÌÅ#ÛÏ�É ���ÅÈ �$áÄ � �3���Î. Ë+�ÅÛ�ÄÊã
Å��Ä ��ÏÄ � û*åî "�� äÄäæ.Ä"�*$Å��� ، á�È$

 û*åî "�ÄáßÏêÄÄÌÄá�×��Ä å++�Ï� "�*$Å��� ،���*Ä �ÄáßÏêÄ �%Öå��" 	�ß�Ä" äç�Ä '�Ä � á�×��
 å#ÿÏ
 	�ß�Ä$ �Å�0Ä äæ Ç�Å×È à%Ö%��Ä �#ë�Ä '�� å���ÅÈ $Ä .
ÈÅë�Ä Å#�3Þ �� �+ûÏë� Ë�ÂÅ�

 )�ÅÏ�Ä ��ï�Ä )
 Å�� Å#ÛÏ�È Å��� )Ï�Ä ÌÄá�×��Ä �+È ���Ï�Ä 
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3-  ÌÄ$à.Ä ù*åîáßÏêÄ �û*åï ÄÄ$à.2 ÌÄåÖء Å#� �Ë�ÂÅï، Ó� �å++�Ï å#ÿ� Å����Ä Ì
ÌÄá�×��Ä%، ë�Ä ÜÅ���� '�� Ì ðå�ø%�÷�،áÈ$ºء å� ôÂÄåïÄ Ø Ë+��å�Ää%ó� 

 

4-  �Ä%���Ä ù*åîáßÏêÄ �*åïÄ Ä ø*$Å��� �Å�Ï�3� '�Ä �á�×� $º ËÉÏ�� Ë��Ïß� $º %Öå�ÄÄ '�Ä �á�×�� 
$º ËÉÏ���Ä  Ë�ÈÅë�Ä 

5- ÑÛÉ�Ä �Èå�: Ï�Ä ÆË��� $º Ë��Ö 
 (Èå�Ä �ÛÉ� ÐÛÉ�� åó�� �� ÐÞÄàÄ �á�×�� $º ËÉÏ���Ä ºáÉ* 
ÛÉ�Ä Ðàå×�É áÉ�Äء  )
 .ËÈÅÏ��Ä 

 

6- çÖ ء�+òÅ�Ï�Ä: áßÏêÄ �ç×ء +òÅ�Ï�Ä �Êá"Åï�� ÂÅóß�ÄÄ ðåÓ�. Å�%+î 

7- çÖ äæ ءË�*Å���Ä: áßÏêÄ �ç×ء Ë�*Å���Ä Êá"Åï�� Å*%ÏÛ� Ìÿ��Ä � ÌÅ���� 

9-  äæå�Ä ôÅ���� ÌÄá�×��Ä% Ìá�� Å#É+ÎåÎ% 
 (Ä ÙÎá�×� $º ËÉÏ��، ���* �å++�Ï �îÄ �Å���� Ì
Ä )
.Êã
Å��  '��+ÉëÄ ��ÅÓ��، á� ÷�Î �Ä �%�ÏÄ �æ%�å�  åÉ�ºå�òº$º ، $ºå��Ä Ë�*åøÄ ô� )ÎÏÏ Ù*
¾ ��å� Ë+�Å��º ôÄ%� � Ë��Ïß�Ä ��Å�%���� Ì%Û �� � . 	�� 

 

 :Êã
Å��Ä �*åÛÎ Å����* �Ä%���Ä ù*åî �3Þ �� 

1 �Ä%���Ä ù*åî '�� ù�÷�Ä äÄå�ÏêÄ �� äÅë+�Ä è$Å� äçÈ ù�÷� . 

2 Æ%�û��Ä �Å���Ä '�¾ Êã
Å��Ä ÇÛë� . 

3 .äÅë+�Ä è$Å� äæ äåÛ� �Ò . 

  

  äæ �3Þ �� ËîÅï�Ä �×Ú %" $ Å#� áÚ 'ó�º ãÞ»Î (º Êã
Å��Ä å+É�Î Å����* :Êã
Å��Ä å+É�Î
 �Ä%���Ä ù*åî '�� à%Ö%��Ä å+É�Î 

  ù�÷�ÅÈ ��ê.Ä '�¾ ÊàÅ�ÏêÄ äæ '�¾ å+É�Ï�Ä äæ �%ÛÏ* áÚ 'ó�º '�¾ Êã
Å��Ä å+É�Î á��
 Å#�×Ú '�¾ Êã
Å��Ä ÊàÅ�ÏêÄ �Ï* !+�� .Å#+
 Êã
Å��Ä å+É�Î �Î Êå� åÞ¸ �×Ú '�¾ (º 
ÈÅë�Ä 
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  )øåî '�� à%Ö%��Ä å+�óÎ äæ �3Þ �� Êã
Å��Ä å+�óÎ Å÷*º ���* :Êã
Å��Ä å+�óÎ
 Êã
Å��Ä ÊàÅ�ÏêÄ �� ���Ï�� äæ ��ïÈ �Å#��Ä ù*åî '�� Êã
Å��Ä �ö$ %" $ Å#� áÚ '�àº '�¾ �Ä%���Ä

¾ ÊàÅ�Ïê2Ä  ã" '�ëÎ $ 
ÈÅë�Ä Å#�×Ú '�¾ .'��.Ä '�¾ ÊàÅ�Ïê 

  

  ù*åî '�� à%Ö%��Ä �3�2Ä äæ �� Êã
Å��Ä �3�Ä �Ï* :Êã
Å��Ä �3�Ä 

  

  :��Å�º Êá� �� Êã
Å��Ä �3�Ä Å÷*º ���* ��� $ 

1 .�Ä%���Ä ù*åî �� Õ�Å�åÉ�Ä $º Êã
Å��Ä Ë�%�*º '�� �+Ï+�ÅÏÏ� �+Îå�� . 

2 .�3�Ä å�º äÅÏß� å#ÿÎ )Ï�Ä Ë+�å��Ä Ë�ÂÅ��Ä �� Êã
Å��Ä ç�ä '�� ÊáÚÄ$ Êå�� . 

3 .�3�Ä å�º äÅÏß� �Ò 	�� Ë�ÂÅ� ÙÏ�� . 

4 äÅÏß� �Ò Êã
Å��Ä äæ '�� �+�+�Ä è$Å� äçÈ ù�÷� Êã
Å��ÅÈ ðÅß�Ä äç�Ä ýÚ3� �Å#��Ä ù*åî �� .
 .�3�Ä å�º 

5 Ù+ÎÅ���Ä ËÚ%� äÅóÏÞÄ �áßÏë� .Alt+ F4 . 

  

äÄ$Ú�Ä �*àÅ�ò : 

 �$á�ó�Ä ��â '�� �ÅÓ� �+�� �ÂÅ�È ËòÅÞ Ë�+�� ÌÄàÄá�¾ å++�Ï� å#ÿÎ ËòÅÞ 
*àÅ�ò �� ÊäÅÉ�
 �Å#��Ä ù*åî ñÂÅóßÈ ðÅß�Ä (º ÇÏ���Ä Ùûê ñÂÅóÞ ÌÄàÄá�¾ å++�ÏÈ ðÅß�Ä �$á�ó�Ä $º

 

Ä%�( Ë+ë+Âä äÄäæº ËÒ3Ò '�� (%ÏÛ* �$á�ò– Å��¾ ء å�º–  )
+ÉûÎ 

 

�÷�Ä á�� :

Ä%� ðÅß�Ä äÄ%Û�Ä �$á�ò �3�¾ �� àáÛ��Ä àÄá�0Ä 
+ÉûÎ �Ï* 

Ä%� äæ '�� ù
 .àÄá�0Ä Äã#È 

Å��¾ ءÅ��¾ �Ï* äç�Ä Äã" '�� ù�÷�Ä á�� :å�º ء �$á�ò �3�¾ �� Å#�++�Î �Î )Ï�Ä ÌÄàÄá�0Ä Ë
Å�
 .äÄ%Û�Ä 

  �$á�óÈ üÅ�ÏÚ2Ä �� Êá*á×�Ä ÊàáÛ��Ä ÌÄàÄá�0Ä 
+ÉûÎ �Ï* 
+ÉûÎ äæ '�� ù�÷�Ä á�� :
+ÉûÎ
åÞ¸ àÄá�¾ ã+��Ï� äÄ%Û�Ä . 

 

 إعداداتالعرض : 
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�*Ä ���ÛÏ� �ëÉÄ ÙøÏ��� ÆàÄá�¾%Ä !ÎËîÅî% �%Ï�Ä � ���*%%ò%�ÄÄ  ã" '�Ä  �Êã
Å��  ��*åû �
Äû�÷� Ä '�� äç� '��ëÄ ÙøÏ���Ä ��$ Æ Êã
Å����* Ë�áë���ÄÄ �" ñ+óßÎ äÅ+ÏÞPersonalize 

)
 Å�� Êã
Å� å#ÿÏ
 " 

  Å�àº ��ï�Ä 

 

 

 

 حساب مستخدم جديد ء إنشا

Åï��å�.Ä äÅÏß ء 0$ ��ÛÏ�Ä ËÚ%� ÙÏ�� á*áÖ �áßÏë� ÆÅëÚuser accounts  

 

 å�.Ä Å#�� äÅÏß�$ �+�áßÏë��Ä ÌÅÈÅëÚ Êã
Å� Å�� å#ÿÏ�Manage another account  )
 Å��
 . ��ï�Ä 
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 �� Å�� ôå�Î )Ï�Ä Ë+�ÅÏ�Ä Êã
Å��Ä Å�� å#ÿÏ� �Åÿ��Ä '�� Å+�ÅÚ Êà%Ö%��Ä ÌÅÈÅëÛ�Ä 

 

 å�.Ä äÅÏß� Å#��$Create a new account  Ë+�ÅÏ�Ä Êã
Å��Ä å#ÿÏ� 
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 �%�Î �º �÷
.Ä$ ÌÅ+Ú3ó�Ä àáÛ� �Ò  ¼Åï�¾ á*å� (ã�Ä ÆÅëÛ�Ä �êÄ Å#+
 ÇÏ�� Ñ+Ú
administrator  äæ ù�÷� �ÒCreate account Åï�¾ �Ï+� ء Ë+ÂÅ#��Ä Êã
Å��Ä ôå�$ ÆÅëÛ�Ä 

 

 

 كلمة السر الخاصة بك ء تعديل أو إلغا 

 å�.Ä äÅÏß�$ ºáÈÄ Ë�ÂÅ� ÙÏ�� æ$á�*$ )
 Å�ÈÅëÛÈ ËòÅß�Ä åë�Ä Ë��� å++�Ï�-  ËÚ%� ��ÛÏ�Äcontrol 

panel  å�.Ä äÅÏß� ��ÛÏ�Ä ËÚ%� ��$- ’ �+�áßÏë��Ä ÌÅÈÅëÚUser Accounts  Êä%ó�Ä )
 Å�� 
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 Ë+�ÅÏ�Ä Êã
Å��Ä Å�� å#ÿÏ� 

 

 å�.Ä Å#�� äÅÏß�$Change your password  Ë+�ÅÏ�Ä Êã
Å��Ä Å�� å#ÿÏ� 
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 äç�Ä ù�÷� �Ò Å�È ËòÅß�Ä åë�Ä Ë��� ËÈÅÏ�È �%�� Ñ+ÚChange password -  Ë����Ä å++�Î �Ï+�
 Ì3*á�Ï�Ä ý�Ú$ )
 Å�� �+�áßÏë��Ä ÌÅÈÅëÛÈ ��ÛÏ�Ä Êã
Å� �� åë�Ä Ë��� �ãÛ� Å�º 

 

  

 åë�Ä Ë��� Ë�Äæ¾ å�.Ä äÅÏß�- Remove your password  )
 Å�� �ãÛ�Ä á+�»Î Êã
Å� Å�� å#ÿÏ�
 Êä%ó�Ä 

 

 äæ '�� ù�÷� Å"á��$remove password Å��Ä �Ï+� ء Ì3*á�Ï�Ä ý�Ú$ åë�Ä Ë��� 

  

 ص بك تغيير صورة الحساب الخا

 Ë+�ÅÏ�Ä Êã
Å��Ä å#ÿÏ� ñ+óßÎ å�.Ä äÅÏß�$ ÇÏ���Ä Ùûê )
 Ë�äÅ
 ËÚÅë� '�� )�+�+�Ä äç�ÅÈ å��� 

Eng
.w

al
ee

da
lk
ur

di



 

 å�.Ä äÅÏß�$change your account picture  Ë+�ÅÏ�Ä Êã
Å��Ä å#ÿÏ� 

 

 Å�äÅ+ÏÞÄ �� Êä%ò �ö$ $º Å�Éë� Êà%Ö%��Ä ä%ó�Ä �� äÅ+ÏÞ2Ä Å�" �� ���*$  ã" ÔäÅÞ ��
 äç�Ä å��È ��â$ Ë�%�×��Äbrowse for more pictures  Ë+�ÅÏ�Ä Êã
Å��Ä å#ÿÏ� 
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 ù�÷�$ Å"äÅ+ÏÞÄ á*å� )Ï�Ä Êä%ó�Ä �Å�� àáÛ�$open  á+�»Ï� Ë+�ÅÏ�Ä Êã
Å��Ä å#ÿÏ� ôå�$ Ë+����Ä
 Êä%ó�Ä 

 

 �%Þá�� Ë+ë+Âå�Ä ËîÅï�Ä )
 å#ÿÎ Êá*á×�Ä Êä%ó�Ä ÙÉóÎ$ 
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 ÌÄá�×��Ä $ ÌÅ����Ä 

 �Å#� Ç��ºWindows  �áßÏë* .ÌÄá�×��Ä$ ÌÅ����Ä )
 ����Ä �ç�ÏëÎWindows  å+
%Ï� ÌÄá�×��Ä
 ÌÅ����Ä �Öº �� �*çßÎ �Åÿ�åÎ%+É���Ä '�� ، Ç+ÎåÏ� &%���Ä �ä%�Ä ÌÄá�×� �áßÏëÎ Å�� Å�Å�Î

 �Ä%�º '�� ÌÄá�×��Ä (%ÏÛÎ �º ���* .ÌÅ��� Ë�ÄçÞ )
 ÌÅ�%����Ä� Ë��Ïß�ÌÅ����Ä �� Êå+Ó ، �Ó�
ÌÄá�Ïë��Ä ،'�+ê%��Ä$ ،ä%ó�Ä$ ،%*á+��Ä$ ، ��Ä%� �� Å#��� $º ÌÅ����Ä Ýë� ���*$ .Õ�ÄåÉ�Ä$

&åÞº ،åÞ¸ á�×� �Ó� ،åÎ%+É�� $º ،Í�åÏ�0Ä $º ،Åï�¾ ���* Å�� .Å#Î»ï�º ÌÄá�×� '�¾ ء ÌÄá�×�
�ÅÓ��Ä �+Éê '�� .ÌÄá�×� ��ö ،á�×� )
 Å#�çßÎ$ ÌÅ��� Áï�Î Í�� Äâ¾ ÌÄá�Ïë��Ä ،Åï�¾ ���+
ء 

åÞ¸ ��%� '�¾ á*á×�Ä á�×��Ä ��� Ìäå� Äâ¾ .ÌÅ����Ä (%ÏÛ+� ÌÄá�Ïë��Ä ��ö á*áÖ á�×� ، ���+

 "	���Ä á*á×�Ä ��%��Ä '�¾ !ÉÛê$  á*áÛÏÈ !ÎÅ*%ÏÛ� �� !��� Ë�%#ëÈFile  :" 

 

Ä .Å"å+� �� ÌÅ�%��� Ë�%�×� ç++�Î �� åÎ%+É���Ä ���Î )Ï�Ä$ �*çßÏ�� Ë+êÅê.Ä ÊáÚ%�Ä %" 	���
 ÌÅ�Å+É�Ä �� Ë�%�×� %"$Å#�ÅÖåÏêÄ �áßÏë��Ä �+ûÏë* ،Å"å++�Î $º ،Å#
ãÚ $º ،Å#ÿ�Ú $º ، $º
ÔÄåÞ¾ æÅ#Ö '�¾ Å#�Åêä¾ ، )�$åÏ��¾ á*åÈ Õ�Å�åÈ $º Ë�ÈÅø �Ó� 

 

 الملفات: ء إنشا

*åø �Å�"Åï�0 Ë�*åê Ë� ءÄäÅóÏÞÄ �÷Î Õ�ÄåÉ�Ä õ�È 	�� Åï����Ë�*åê Ë�*åûÈ Å#ÎÅ ء 0
 :)�ÅÏ�Å� 

 

 .á�×� (º )
 $º ÇÏ���Ä Ùûê '�� �+�+�Ä è$Å� äçÈ ù�÷� • 
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 á*áÖ å#ÿÎ )Ï�Ä Ë+�å��Ä Ë�ÂÅ��Ä �� äÅÏß� •New . 

 Æ%�û��Ä 	���Ä Å#�� äÅÏß� &åÞº Ë+�å
 Ë�ÂÅ� å#ü • 

  

 أنواع الملفات : 

Åï�¾ á�� ء :�+�ë� �� 	�»Ï* 	�� (º �êÄ ËÈÅÏ� �»È ýÚ3� 	���Ä �êÄ ËÈÅÏ� á�� $ 	�� (º 

 Ë*Å�� 	���� �êÄ �ö$ ���* 	���Ä �êÄ %" :�$.Ä �ë��Ä219  .�åÚ 

Å�ÂÄà �%�Ï* $ )!�%�( 	���Ä àÄáÏ�Ä %" :)�ÅÓ�Ä �ë��Ä  .Ë*ç+���2Ä Ë���ÅÈ ÄåóÚ �åÚº ËÒ3Ò �� 

 !�%� $ 	���Ä �êÄ �+È �ó�*  Å�àº ��ï�ÅÈ Ùö%� Å�� ).( Ëû�� 

 

 

"ÌÄá�×��ÄFolder " 

  

Ë+�%êå�Ä �áßÏë��Ä 
+ÉûÎ ÌÅ#ÖÄ$ )
 ÌÅ����Ä$ Õ�ÄåÉ�Ä �Öº �� Ë*$ÅÚ ، ËîÅï�Ä '��  ç+�åÎ �Ï*
 )ç�ä( Ë+�%êä Êä%ò ËûêÄ%È 

 ÌÅ��� Ç�%Ïë* �º ���*$ ðå��Ä '�� ÌÄá�Ïë��Ä$ Õ�ÄåÉ�Ä �+ÿ�Ï� Ëû+ê$ %" á�×��Ä .ÌÅ��� á�×��
�$ 3Ó� .Ë+
Åö¾ ÌÄá�× 

  

 Ýë��Ä–  ñ��Ä–  
ó��Ä 

( Ýë��Äcopy  .Ë+êÅê.Ä Ëßë��ÅÈ üÅ�ÏÚ2Ä �� åÞ¸ �Å�� )
 Å#�ö$ $ 	�� �� Ëßë� ãÞº :) 

 ( ñ��Äcut  .åÞ¸ �Å�� '�¾ �Å�� �� 	�� ��� : ) 

 ( 
ó��Äpaste  2Ä �Ï* 2 ñ��Ä $ Ýë��Ä (å�º �º (º Å�"ã+��Î á�� ñ��Ä $ Ýë��Ä Í+ÉÓÎ å�º : )
 
ó��Ä å�º ã+��ÏÈ :�åø Êá�È ñ��Ä $ Ýë��Ä å�º ã+��Î ���* 

 

:2$Ä-  Ë�ÂÅ��Ä �� ÌÅ����Ä Ýë�Organize  

1 ( !ßë� Æ%�û��Ä á�×��Ä $º 	���Ä àáÛ� .copy  ) 

2 Ë�ÂÅ� ÙÏ�� .Organize å�º Å#�� äÅÏß� $  .Ýë� 

Eng
.w

al
ee

da
lk
ur

di



3 .!+
 Ëßë��Ä �ö$ Æ%�û��Ä Êã
Å��Ä ÙÏ�� . 

4 Ë�ÂÅ� �� .Organize  .
ó� å�º äÅÏß� 

 

 :Å+�ÅÒ-  :�+�+�Ä è$Å� äæ �ÄáßÏêÅÈ Ýë��Ä. 

1 .!ßë� Æ%�û��Ä 	���Ä àáÛ�. 

2 .Ýë� å�º äÅÏß� $ 	���Ä '�� �+�+�Ä è$Å� äçÈ ù�÷�. 

3 .Å#+
 Ëßë��Ä �ö$ Æ%�û��Ä Êã
Å��Ä ÙÏ��. 

4 å�º äÅÏß� å#ÿÎ )Ï�Ä Ë+�å��Ä Ë�ÂÅ��Ä �� $ Êã
Å��Ä �ÞÄà �äÅ
 �Å�� )
 �+�+�Ä è$Å� äçÈ ù�÷�.
 .
ó� 

 

:ÅÓ�ÅÒ-  :Ù+ÎÅ���Ä ËÚ%� ÌÄäÅóÏÞÄ �ÄáßÏêÅÈ Ýë��Ä 

1 .!ßë� Æ%�û��Ä 	���Ä àáÛ� . 

2 (äæ '�� ù�÷� Ù+ÎÅ���Ä ËÚ%� �ÄáßÏêÅÈ .CTRL+C  .Ýë��Ä å�. 

3 .Å#+
 Ëßë��Ä �ö$ Æ%�û��Ä Êã
Å��Ä ÙÏ�� . 

4 äÅóÏÞ2Ä �áßÏë� Ù+ÎÅ���Ä ËÚ%� �� .CTRL+V  .
ó��Ä å�. 

  

: Å�ÈÄä-  :äÅë+�Ä è$Å� äçÈ Ì3
2Ä $ ÇÛë�Ä �ÄáßÏêÅÈ Ýë��Ä 

1 àÄå��Ä Ë#Ö%�Ä Êã
Å� $ !ßë� àÄå��Ä á�×��Ä $º 	���Ä '�� (%ÏÛÎ )Ï�Ä äáó��Ä Êã
Å� �+Îã
Å��Ä ÙÏ�� .
�Ä �ö$ .!+
 Ëßë� 

2 .Ë#Ö%�Ä Êã
Å�  Å×ÎÅÈ äÅë+�Ä è$Å� äæ ËûêÄ%È á�×��Ä $º 	���Ä ÇÛë� . 

3 äæ '�� ù�÷�ÅÈ �%�� Ë#Ö%�Ä Êã
Å� �%
 .CTRL  �%�� (ã�Ä 	���Ä )��� �Ò Ù+ÎÅ���Ä ËÚ%� ��
 .!ÉÛëÈ 

  

:Åë�ÅÞ-  :�+�+�Ä è$Å� äçÈ Ì3
2Ä $ ÇÛë�Ä �ÄáßÏêÅÈ Ýë��Ä 

1��Ä Êã
Å� �+Îã
Å��Ä ÙÏ�� . àÄå��Ä Ë#Ö%�Ä Êã
Å� $ !ßë� àÄå��Ä á�×��Ä $º 	���Ä '�� (%ÏÛÎ )Ï�Ä äáó
 .!+
 Ëßë��Ä �ö$ 
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2 .Ë#Ö%�Ä Êã
Å�  Å×ÎÅÈ �+�+�Ä è$Å� äæ ËûêÄ%È á�×��Ä $º 	���Ä ÇÛë� . 

3Å��ÅÈ �%��
+#Å(. ء .  Ëßë��Ä �ö$ àÄå��Ä Êã
Å��Ä( Ë#Ö%�Ä Êã
Å� �ÞÄà á�×��Ä $º 	���Ä 

4+�å
 Ë�ÂÅ� å#ÿÎ . .�ö%��Ä Äã" '�¾ Ýë� Å#�� äÅÏß� Ë 

  

Å�ÈÅê Å��� Ìå� )Ï�Ä ËÏë�Ä �ÚÄå��Ä é�� !� ñ� å�º ã+��Î :ËÿÚ3�  �á� �� ��� $ Ýë��Ä å�º ã+��ÏÈ
 .åÞ¸ �Å�� '�¾ �Å�� �� ��� Ë+��� (º Å#�Å�� )
 Ë+ë+Âå�Ä Ëßë��ÅÈ üÅ�ÏÚ2Ä 

 

:ÅêàÅê-  äÅóÏÞ2ÄShortcut  

 ��%� '�¾ ÆÅ"ã�Ä �$à á�×� $º 	�� ÙÏ
 $º äå�Ï� ��ïÈ �áßÏë� Õ�Å�åÈ �+�ïÏ� Ë�*åê Ë�*åø
 !Ï+ÉÓÎ 

 فوائد الطريق المختصر: 

1- %×��Ä �$áÈ Õ�Å�åÉ�Ä '�¾ �*åë�Ä �%ò%�Ä ء . �ÂÄ%��Ä '�¾ 

2-  . �+Ãö �×Ú &%ê ç×Û* 2 !�. Ç�ó�Ä ðå��Ä '�� Ë+�*çßÎ ËÚÅë� å+
%Î 

3-  . )�ò.Ä 	���Ä Ë�#� é��È �%�* 

  

Åï�0 �åø Êá� �Å�"$ ء :äÅóÏÞ2Ä 

 ..Õ�Å���Ä Ë�*åø �ÄáßÏêÅÈ * 

 .äÅóÏÞÄ 
ó��Ä $ Ýë��Ä * 

 

Åï� Õ�Å���Ä �ÄáßÏêÅÈ äÅóÏÞÄ: ء ¾
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1ÇÏ���Ä Ùûê �%
 ��*.Ä è$Å��Ä äçÈ å��Ä. ،á*áÖ '�¾ åîº$ ، .äÅóÏÞÄ �%
 å��Ä �Ò 

2åó���Ä ��%� �Èå� )
. ،� ÇÏ�Ä á*åÎ (ã�Ä Õ�Å�åÉ�Ä $º 	���Ä �êÄ$ äÅëäÅóÏÞÅ� !Ï
Åö¾ ، $º
	���Ä �êÄ �� ÑÛÉ�� ôÄå�ÏêÄ �%
 å��Ä ، .)�ÅÏ�Ä �%
 å��Ä �Ò 

 

 

3äÅóÏÞ2Ä ÍÛÎ  ä%#ü á*åÎ (ã�Ä �ê2Ä ÇÏ�Ä. ،Å#�¾ �%
 å��Ä �Ò .ء 

 

Å#�¾ '�� ù�÷�Ä á�� * ء �#ë�Ä �� äÅóÏÞ2Ä �å�* ÇÏ���Ä Ùûê '�� äÅóÏÞ2Ä ç�ä å#ÿ*
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Operating System 

It is a set of software responsible for managing resources (computer 

hardware) and computer software, and it represents an intermediary 

between the user and the computer hardware. In other words, it is a 

means to run user programs, and it performs basic tasks such as: 

managing and allocating computer resources (memory, hard disk, access 

to devices). accessories, etc., arrange the priority of dealing with 

commands, and control input and output devices such as: the keyboard, 

as well as to facilitate dealing with networks and file management . 

 

Windows operating system 

Definition of the Windows operating system The Windows operating 

system is a computer operating system developed by Microsoft with the 

aim of running personal computers. Where Windows versions are used 

by 90%. 

 

 

 

 

 

What is the use of the Windows operating system? 

The operating system is the most important software that runs on a 

computer. It manages everything related to the computer's memory and 

the processes that take place in it, as well as both software and hardware 

(software and hardware). It also allows you to communicate with a 

computer without knowing how to speak a computer language. Without 

an operating system, a computer is useless. 



1.To switch on a computer, you use the power button, this is a universal 

symbol for how to power on devices. When you press this button, your 

computer will start “booting up”. This means your computer is getting 
ready to be used and can take anything from 10 seconds to 5 minutes 

depending on the computer. 

2.Once the computer powers up after a short period of time you will 

come to a screen with a random artistic image as the background. 

 

3.Press the left mouse button once and it will disappear and be replaced 

with this. Click on “Sign in” with the left mouse button. If you have a 
password type it into the box that appears and click the arrow button. (If 

there isn’t a password created it will just sign in straight away). 

 

 

 

Desktop 

The main screen area that appears after turning on the computer and 

logging into the operating system 

 

 

 

 

 

 



1.This PC: Through it, hard disks, floppy disks, or units can be accessed 

Secondary storage such as an external hard disk, memory flash, or other 

Storage units. 

 

 

2.My Document: It stores files such as photos, videos, and documents. 

It is one of the main desktop components. 

 

 

3.Recycle Bin: it is one of the basic icons on the desktop that contains 

files that have been deleted these files can be recovered by entering the 

recycle bin, right-clicking, and selecting the command (Restore) and this 

deletion is considered temporary. as for the deletion, it is final, by 

pressing right-click on the recycle bin and select (Recycle Empty Bin). 

 

 

4.Microsoft Edge: It is a browser found in all modern versions of 

Windows, it's faster, safer, and includes a lot of new features, such as 

accessing blogs and social networking sites, as well as sending and 

receiving email Depending on the company like (Yahoo or Google).  

 

 

 

5.Start Menu: It is a list on the taskbar containing all the programs in 

which the computer has been turned off and restarted 

 



6.My Network: Through it, access to networks on the computer is 

controlled by all its settings. 

 

 

 

7.Task bar: It is a bar located at the bottom of the desktop that contains 

the start menu by accessing the history, controlling the volume, 

changing the language, and the Internet And other tools. 

 

 

 

How to change the size of desktop icons 

Wish the desktop icons in Windows 10 were bigger so you could 

stop squinting at them or they'd be easier to tap on a touch screen 

laptop? Or do you wish they were smaller so the shortcuts didn't 

take up as much space on your laptop's screen? Not to worry, we 

have a list of short steps on 

how to change the icon size in Windows 10. 

 

How to make small desktop icons: 

Right clock           view           small icons 

 

How to make medium desktop icons: 

Right clock           view           medium icons 

 

 



How to make large desktop icons: 

Right clock          view          large icons. 

 

How to make the arrangement of icons on the 

desktop automatically:  

Right clock          view         auto arranges icons. 

 

How to show icons on the desktop: 

Right clock           view          show desktop icons. 

 

             How to arrange icons according to size: 

               Right clock          sort by         size. 

How to arrange icons according to name: 

 Right clock           sort by         name. 

 

How to arrange icons according to item type: 

 Right clock           sort by item type. 

 

How to arrange icons according to data modified:  

Right clock            sort by data modified. 

 

 
Refresh: In general, refresh is another way of describing 
reloading or updating what is being displayed or stored. For 
example, if you were on a web page, refreshing the page would 
bring up the most recent content published on that page. 
Essentially, you're asking the site to send your computer the 
newest version of the page you're viewing. 

 

How to Create a New Folder in Windows 10?  

There are two ways: 

Method 1: Create a New Folder with a Keyboard Shortcut. 

ctrl + shift + N 



Method 2: Create a New Folder by Right-Clicking  

Right clock           new         folder. 

 
A file: It is a collection of information that is classified and stored 
in various ways to keep it and easily accessible at any time. 

 
A folder: is a virtual digital space in which a group of files of a 
certain type or of several types and formats are stored. 

 

Subfolder: A folder stored inside another folder. 

 

Naming folders: Should the folder name be short and indicate something, 
it is best if it indicates in one way or another the content of the folder. This 
makes searching for it easy, and anyone who glances at your computer 
quickly understands its organization. 

There are several ways to rename a folder: 

1-To rename a file from the context menu, right-click on a folder, and 

click "Rename" from the context menu that appears. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



2-Select the file or folder whose name you want to change by clicking on 

it with one click of the left mouse button, and then adding the new name. 

 

 

 

 

 

 

 

 

 

 

 

H ow to show the main icons on the Windows 10 desktop? 

Right clock           personalize          themes         desktop icons setting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



How to change Windows 10 desktop background? 

1-Right click. 

2-personalize. 

3-Click on the background and the page for the background images will 

appear. 

4-Click on the box below Background to select a specific picture or 

color, or you can do a background slideshow. 

How to change windows 10 lock screen?  

1- Right click. 

2-personalize. 

3-lock screen. 

4-Click on the box below Background to select a specific picture or 

windows spotlight, or you can do a lock screen slideshow. 

 

How to change windows 10 themes? 

1.Right click the Start menu and select Settings.  

2.Choose Personalization from the Windows Settings menu. 

3.On the left, select Themes from the sidebar.  

4.Under Apply a Theme, click the link to Get more themes in the store. 

5.Choose a theme, and click to open a pop-up to download it. 
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Word 2016 

Home Tab 

1- Clipboard group 

2- Font group 

3- Paragraph group 

4- Style group 

5- Editing group 

1- Clipboard group 

Cut, Copy and Paste 

highlight the text and go to the Home tab in the Clipboard group 

 and click Cut or Copy. You can also right click on your mouse 

and select Cut or Copy. 

the Paste Options button provides different options, depending on the source of the 

content as in the table below, see figure 1. 

Keep Source Formatting: This option preserves the look of the original text. 

Keep Text Only: This option removes all the original formatting from the 
text. 

Merge Formatting: This option changes the formatting so that it matches the 
text that surrounds it.

highlight the text or select text  تعني
 تظليل النص 

خطوات التنفيذ تقريبا متشابه Ϸغلب التنسيقات 
سوف نطبق على البعض ويقاس على البقية لتجنب 

 التطويل 
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Figure 1 copy and past 

2- Font group 

Font Formatting  

Highlight the text you want to format and then select the font, size, style, and color 

under the Font group. 

 For additional font options, click the Show Font 

Figre 2 change the type of font and size of it 

1

2

3

4 

1

2
3

4
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Bold (Ctrl+B): Highlight the text -> from font group -> click B 

Italic (Ctrl+I) : Highlight the text -> from font group -> click I 

And so on for all 

Increase Font Size  

Decrease Font Size 

Change Case:  

This for English language 

Font Color 

MSC.Ahmed Kareem
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3- The Paragraph Group 

Paragraph Formatting  
Paragraph formatting options are available under the Paragraph group. The following 
options are available from the Paragraph group:  

- Bullets and numbered lists 

- Indentations, Sorting & Display 

 Format Symbols 

- Alignment 

- Line spacing, Shading, & Borders 

. 

Figure 3: Bullet and center alignment 

For additional paragraph 

formatting options, click the 

Show Paragraph Dialog Box 

icon 

1 

4 

3 

2 
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How to align text 

1. From the Home Tab, find the Paragraph toolbox.

2. Select the text that you would like to align.

3. Select the icon for left, center, right, or plain justify, justification. Your text will have

the justification of your choice 

How to change the line and paragraph spacing 

1. From the Home Tab, find the Paragraph toolbox.

2. Select the text that you would like to change the spacing.

3. Select the icon for line and paragraph spacing. The dropdown arrow will allow you

to see the different choices for line and paragraph spacing 

As shown in this figure 

4- Style group

Changing the style of text can make your document look amazing. You have several 

choices to choose from

How to change the style of text 

1. Select the text that you would like to change the style of.

2. From the Home Tab, find the Styles toolbox.

3. Click the style that you would like to change the text to.

MSC.Ahmed Kareem 
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Create new style 

1- write any text 

2- highlight the text 

3- format the text (size, type .....) as you want 

4- from style group, click the arrow in the right - below in style group 

5- Click the create a Style

 6- Name it and press ok 

We note the style name will appear in the style group 

MSC.Ahmed Kareem
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5- Editing group 

The editing toolbox allows access to the Find tool. This tool 

allows you to locate certain words in your document.  

You can also access the Replace tool which allows you to  

replace words of your choice. 

Find : search on your words inside the document 

Replace : 

1 

3 

2 

1 

3 

2 
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How to use the Replace button 

a. From the Home Tab locate the editing toolbox at the far right of the ribbon.

b. Click the Replace button in the Editing toolbox. The Find and Replace dialog box

will display. 

c. Type in the word to find and then type in the word you would like to replace it with.

d. Click Replace or Replace all.
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1- Insert 

 

1.1 Table 

To create new table do the following 

Insert        table        insert table        write number of columns & row    ok  

See figure 1 
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1.2  Picture 

To insert picture for your word document, do the following 

Insert         Picture          select the desired image file in dialog box          click Insert  

See figure 2 

 
 

 

 

 

 

 

 

 

1.3  Shapes 

Insert        shapes        select desired shape       draw the shape in the desired place 

1.4  Screenshot 

Insert        Screenshot        select desired screen or window of any opened 

program Insert        Screenshot       screen clipping 

1.5  Hyperlink 

A hyperlink is a word, phrase, or image that you can click on to jump to a new document or a new section within the 

current document 

Select the word/phrase/ image        insert        hyperlink       select the file you want   ok   

See figure 3 
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 If move mouse to the linked text as shown in figure 4-B will appear phrase (Ctrl + click to follow 

link) and if you do that, the file will be opened. 

 

1.6  Header & Footer 

Insert       Header       select the desired one        update it and write what you want   

see figure 4  
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1.7  WordArt 
 

Insert        WordArt        select desired style        write the text 

Figure 5 

 

 

 

 

 

 

 

 

 

 

 

 

1- Design & Page Layout 

1.1  Watermark 

A watermark is an identifying image or text in paper that appears as various shades of 

lightness and you can do by follow the: 

Design        Watermark       custom watermark       text watermark       write text   ok  

 See figure 6  
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1.2  Page Color 
 

Design        page Background        page color        select color                                                                                                      

As shown in figure 7 

 

 

 

 

 

 

 

 

 

1.3  Page Borders 
 

Design        page Background        Page Borders       select border from border box   ok 

 See figure 8 
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How to change Brightness in windows 10? 

In Windows 10 Select Start, choose Settings, and then select System choose Display. Then 

Brightness and color move the Change brightness slider. 

 

 

 

 

 

 

 

 

 

 

 

How to change night light settings in windows 10? 

In Windows 10 Select Start, choose Settings, and then select System choose Display. Then night 

light. If your night light toggle is grayed out, you may need to update your display driver, toggle 

Schedule night light to on.  

 

 

 

 

 

 

 

 

 

 

Start Settings System Display Brightness 

Start Settings System Display Night light 
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How to change size of text in windows 10? 

Follow the steps below to change both the Text size and the size of App icons as they appear on 

the screen of your computer.  

1. Right-click on any empty space on the desktop  

2. And click on Display settings. Open Display Settings on Windows Computer Alternatively, 

you can reach the Display Settings by going to Settings > System> Display. You will 

immediately notice the Text size and App Icons appearing larger. However, you will have to Log 

Out of your computer and Login back again to implement this change.  

3. Hence, Log out and Login back to apply the changes. 

 

 

 

 

 

 

 

 

  

 

 

 

             

 

 

 

 

 

 

Start Settings System Display Scale&layout 

Change size of text 
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How to change screen resolution on windows 10? 

In the Display screen, scroll down to the "Scale and layout" section. Click the box under 

"Display resolution" to see your available options. 

 

 

 

 

 

 

 

 

 

 

 

 

How to change Display orientation on windows 10? 

Select Start  > Settings  > System > Display, and choose a screen orientation from the drop-

down list labelled Orientation. 

 

 

 

 

 

Start Settings System Display Scale&layout 

Display resolution 
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Quick Actions 

Windows 10 makes it easier for you to add, remove, or arrange the Quick Action button ns in the 

Notifications & Actions Center. The Action Center displays four Quick Actions, with an option 

that lets you Expand or Collapse the Action Center in order to show more than four buttons. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start Settings System Display Scale&layout 

Display resolution 

Start Settings System Notifications & actions 

Quick actions 
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Notifications 

Action center in Windows 10 is where you will find your notifications and quick actions. Change 

your settings at any time to adjust how and when you see notifications and which apps and 

settings are your top quick actions. 

 

 

 

 

 

 

 

   

 

 

Power and Sleep 

Change Power and Sleep Settings in Windows 10 to manage your computer uses power. Power 

and Sleep Settings can help to save energy or maximize system performance your devices. 

 

 

 

 

 

 

 

 

 

Start Settings System Notifications & actions 

Notifications 
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Battery saver 

 When the battery saver is enabled in Windows 10, the screen’s brightness is set to a low level, 
and the background activity, and push notifications are disabled to save energy. Windows 10 

enables the battery saver automatically when the battery level below 20% or a custom level set 

by the user. 

 

 

 

 

 

 

 

 

 

 

 

 

Start Settings System 

Screen 

Power & Sleep 

Start Settings System 

Sleep 

Power & Sleep 

1 

2 

Start Settings System Battery saver Battery 
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How to set your time and time zone 

In Date & time, you can choose to let Windows 10 set your time and time zone automatically, or 

you can set them manually. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Start Settings Date & time Time & language 
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Manage display language settings in Windows 

The display language you select changes the default language used by Windows features, such 

as Settings and File Explorer. 

1. Select Start  > Settings  > Time & language > Language & region. 

2. Choose a language from the Windows display language menu, or, next to preferred 

languages, select add a language to install the one you want if it is not listed. 

 

 

 

 

 

 

 

  

Start Settings Date & time Time & language 
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Word 2016 

Microsoft Word 2016 

Microsoft Word 2016 is a word-processing program, designed to help you create 

professional-quality documents. With the finest document-formatting tools, Word 

helps you organize and write your documents more efficiently. Word also includes 

powerful editing and revising tools so that you can collaborate with others easily. 

The Ribbon 

Understanding the Ribbon is a great way to help understand the changes between 

Microsoft 2003 to Microsoft 2016. The ribbon holds all of the information in previous 

versions of Microsoft Office in a more visual stream line manner through a series of tabs 

that include an immense variety of program features. 

Home Tab 

This is the most used tab; it incorporates all text formatting features such as font and 

paragraph changes.  

 

Insert Tab 

This tab allows you to insert a variety of items into a document from pictures, clip art, 

tables and headers and footers. 
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Page Layout Tab  & Design Tab 

This tab has commands to adjust page elements such as margins, orientation, inserting 

columns, page backgrounds and themes. 

 

 

Opening Outlook (word program window) 

You may have a shortcut to Word on your desktop, if so double click the icon and Word will open. If 

not follow the steps below:  

1. Click on the Start button  

2. Click on all Programs  

3. Click on Microsoft Office 

 4. Click on Microsoft Word 2016  

Create a New Document from desktop  

1- Right click then new 

2-  Click Microsoft word document 

After click on the Microsoft Word 2016 or on any Microsoft Word document the 

following window will present 
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The Quick Access Toolbar 

The Quick Access Toolbar is located in the bottom left corner and is intended to store 

the buttons you will use most often. 

 

By default, the Quick Access Toolbar shows the Save, Undo, and Redo buttons, however 

if you click on the drop down arrow just to the right, you can customize it to fit your 

needs. In the example below, I have added the Quick Print button. The Save icon (which 

appears as a floppy diskette symbol) is convenient to click on when wanting to save your 

work instead of clicking on the Save icon from the File tab. 
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File Tab:- 

In Microsoft Word and other Microsoft Office products, the File tab is a 

section on the Office ribbon that gives you access to file functions. For 

example, from the File tab, you can access the Open / Recent file options, 

Save, Close and others tools. The image below is of Microsoft Word 2016 

in the following will explain some functions of file tab 

1- Save 

While editing an existing file, it’s a good habit to often  

save your work. There are two different ways to save  

files. Click the File tab, then just click the Save button.  

The faster option as described earlier, is to click the  

Save button in the Quick Access Toolbar. 

2- Save as  

When editing an existing document, you may want to  

save the file under a different name or in other location  

with same or other name.  

Click on the File tab, click the Save As button and the Save As dialog box 

opens as seen below. In the File name field, type in the new name without 

changing the .docx extension. Click the Save button. 
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Select Location                          Type name 

 

3- Open an Existing File 

To open an existing file, you’ve created, click on the File tab, click the Open 

button and the familiar Open dialog box appears as seen in the next screen 

shot below. 
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Recent Option 

The Recent option in (open) allows you to quickly go to your other documents and 

open them 

If select Browse  

the familiar Open dialog box appears as seen in the next screen shot below. 

 

Click on the file you want, then click Open at the bottom right. 
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4- Print  

Use for print  word document, File then print  

 

 

Encrypt The Word Document: 

To make the word document not available for others, we can encrypt the word 
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document with password.

1- click file

2- click info then protect Docu.

3- choose encrypt with password 

4- write your password
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1- Computer Definition.

• Computer is an electronic machine, that

process the input data according to the given

instructions(program) & gives output information

or signals as a result. It also saves the result for

the future use.

Figure (1) The working of computer contains 1
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• In the past humans use signals to speech and understanding

• Then use fingers to calculate

• Writing on wicker panels and papyrus and then writing

leather panels

• Then writing on paper with ink

• The first calculation machine created

named (Abacus).

• In 1812 created the (Mechanical Calculator)

by the Invented (Pascal) named (Pascalian).

• In same year created (Analytical Machine), ability to

implementation the four operations (Addition, subtraction,

multiplication and division) named (Grand Father).

2- Historical

Development
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• In 1923 appear the first machine named

(Electromechanical Machine) by the Inventor (Hawerd)

from Slvania University in USA.

• In 1946 appear the first computer named (ENIAC)

(Electronic Numerical Integrator And Computer) by the

Inventor (Ekentemockely), this computer used Vacuum

Tubes named (First Generation) .
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• (EDVAC)(Electronic Discrete Variable Automatic Computer)

• computer became able to store

programs instead of the entry  manually. 

• (UNIVAC) (Universal Automatic Computer)

• computer in first time used magnetic tapes

for storing information until 1981 when

manufactured personal computer (PC)

• by International Business Machines Corporation (IBM)
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3- Computer Generations.

• First Generation (1945-1951) 

• Second Generation (1952-1960) 

• Third Generation (1961-1969)

• Fourth Generation (1970 - present) 

• Fifth Generation (present-beyond) 
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Technology: Vacuum Tubes

The first computers used vacuum tubes for circuitry and

magnetic drums for memory, and were often enormous, taking

up entire rooms.

Characteristics 1st Gen.

1-Difficult in using because it was used

for primitive Languages

2- Slow, the time unit in Milli Second. (1 ∗ 10−3).
3- The memory is very limited.

4- Very expensive.

5- High power consumption.

6- Generate a lot of heat.

7- The size is very large.

8- Their were often the cause of malfunctions.
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2-Second Generation (1952-1960) 

• Technology: Transistor

• Invented in 1952 by (William Shockley, John Bardeen,

and William Brattain).

• Characteristics 2nd Gen.

1-Use Transistor instead of Vacuum Tubes

2-Use language more easy than machine language

such as Fortran & Koppel languages.

3-The size smaller than previous generation

4- Increase the speed, the time unit

in Microsecond(1x10−6 .ܿ݁ݏ )
5-Increase the capacity of memory .
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• Technology: Integrate Circuit (IC)

• With appear the Integrate Circuit also appear the third

generation and small computers.

Characteristics 3rd Gen.

1-More increase in the speed, the time unit in

Nanosecond. (1x10−9 .ܿ݁ݏ )
2-Increase numbers of users because easy to use.

3-The size smaller than second generation.

4-The cost is cheap.

5-Multiple practical applications.

3-Third Generation (1961-1969)
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• Technology: Micro Chips

• Created the Personal Computer, The (PC) was introduced by

IBM Corporation, in 1981.

• The number of personal computers in use more than

doubled from 2 million in 1981 to 5.5 million in 1982. Ten years

later, 65 million PCs were being used.

Characteristics 4th Gen.

1-The size is very small.

2-Wide spread.

3-The cost is very cheap.

4-Easy to use.

5-Use languages such as Basic language.

4-Fourth Generation (1970 - present)

9



• Technology: Artificial Intelligence

• In (1985) Japanese development the program for Artificial

Intelligence(control the Robot) .

• Characteristics 5th Gen.

1-The speed is higher than previous generations.

2-The capacity of memory bigger than previous generations

3-The size of equipment is better.

4- Safety in Information Security

5-Created new memory units such as

(CD,DVD, floppy disk …etc)

5-Fifth Generation (present-beyond)
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4- Computer Contains:-

A- Hardware :-Refers to the physical components

(Electronic and mechanical equipment),it includes

the keyboard ,mouse, and monitor and other

devices.

B- Software :- Refer to the programs which consist

of the step by step instructions that tell the computer

how to do its work.
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1- System unit :

Is a container which consists of the electronic components

that make up computer system, two important components of

it:

A- CPU (Central Processing Unit ).

B- Memory dividing to RAM & ROM.

CPU and the memory was installed on system board or mother

board. The mother board connect all system components to

each other.

2- Input/output units.

3- Disk Drivers.

4- Peripherals ( الطرفيةاϷجهزة ).

A- Hardware
Computer main parts:
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1- System unit :

A)- CPU (Central Processing Unit):-

-Also called a processor.

-Carries out instructions that tell computer what to do.

-The CPU is the brain of any computer and most important

element of a computer system.

-It coordinates its function with other computer units, it has

two basic component :

1-ALU (Arithmetic & logic Unit)

2- CU (Control Unit)
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2- CU (Control Unit)

It controls the flow of instruction within

the system. It directs the movement

of electronic signals between memory,

instructions , processed information

and arithmetic logic unit.

It also control the signals between

CPU and output device.

1-ALU (Arithmetic & logic Unit)

Perform two type of operation :Arithmetic & logical .

Arithmetic operation like( addition, subtraction,

multiplication and division).

Logical operation like(comparisons operation).
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B - Memory:
This unit stores instructions and information, and it’s Divided 

into two parts:

1-ROM (Read only memory):

- it is programing chips.

- have programs built into them at factory.

- they are not violet .

- cannot be changed by the user.

- like ROM-BIOS chip.
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2-RAM (Random access memory):

- Also called Primary Memory.

- It stores the data, information and programs temporally.

- the  data can written on it and deleted constantly.

- Called violet because everything is lost as soon as the 

computer is turned off.

-measured by Mbyte, It ranges from 64 MB to 16 GB. 
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Input units :used to enter

the data and commands to

the computer such as:

- keyboard + touch screen

- Mouse 

- Scanner

- Camera

- Microphone (voice inputs)

- Barcode Reader

- Light pen 

- joystick 

- DVD (Digital Versatile Disk)

- Floppy disk

Outputs units: used to show 

the data and commands like:  

-Monitor 

-Printers

-Plotters 

-Data show 

-Speakers 

-Magnetic Tape 

-CD (Compact Disk)

-DVD (Digital Versatile Disk)       

-Floppy disk 

2)-Inputs/Output units:
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3-Disk Drivers:

-Secondary storage : store data and program even after the

power of computer turned off.

Such as: floppy disk, hard disk, and optical discs

(CD , DVD ).

4-Peripherals ( الطرفيةاϷجهزة ):

- Any piece of hardware that is connected to a computer to

perform a special task such

as modem and speakers.
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Thank you
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